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Module 1 Introduction to BME3181 & Microscopy 

Module 1 Lab Procedure 

Introduction: 
BME3181 is a hands-on lab class that teaches students technical skills associated with Biomedical 

Engineering, specifically, biotransport and quantitative physiology, bioimaging, and 

micro/nanotechnology. Lab components include hypothesis testing and analysis, computer 

simulation, lab safety and instrument training, and technical communication. 

By successfully completing this course, you will be able to add these technical skills to your 

resume: 

Microscopy, histological analysis, spectrophotometry, sterile techniques, dilutions, tissue 

culture, data analysis, experimental documentation. 

In this Module you will become familiar with your classmates and instructors, the course 

requirements, and review and practice the use of phase contrast microscopy as your first lab 

skill.  

Learning Objectives 
1. Develop familiarity with the operation of a phase contrast microscope. 

a. Adjusting ocular lenses 

b. Using stage to position specimen 

c. Changing focus 

d. Changing objective 

e. Saving images 

f. Scaling images 

Materials 
Equipment Software Misc 

Phase Contrast Microscope Image J Calibration Slide  

 AmScope Histology slide 

Important Terms 
Calibration  

Phase Contrast  

Inverted Microscope  

Focus  

Objective  

Lumen  

Cross Sectional Area  

Safety 
Handling Biological Specimens: Wear gloves 
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Setup: 

 

Figure 1-1. Labelled illustration of an inverted phase contrast microscope. 

Notes for working with a microscope: 

1. Never touch the lens (ocular or objectives) with your hands or gloved fingers. To change objective, 

turn the rotating nosepiece (also called a turret) but NEVER touch the lenses themselves. The 

objectives are extremely expensive to replace. 

2. Start with the lowest power objective (4x) to locate your specimen and move to high power objectives 

to focus your microscope. ALWAYS carefully watch the lenses move in place under the specimen. You 

can scratch the lens by rubbing it against the slide! 

3. Make sure your phase ring matches your objective 

4. When saving images, save them in your sections folder on the laptop desktop with a useful name (your 

team name, microscope objective or other important settings, short description of what it is.  E.g. 

“Breen_20x_Vein_control.tiff”. 

5. If you will be making measurements on any images, make sure to take a calibration image. Using the 

same objective, and microscope settings, snap a picture of the calibration slide or something else of 

known dimensions.  

6. Never leave slides or culture plates on the stage of the microscope. 

7. Reset objectives and phase rings and turn off microscope after each use and cover the with the dust 

cover if you are the last person to use the microscope. 
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BME3181: Microscopy Practical 

1. Obtain a cell specimen for imaging. 

2. Locate and operate a phase contrast microscope to capture and save an image of the cell 
specimen which will be used for further quantitative data analysis. 

 

FOR INTRUCTOR USE 
 

EXCEPTIONAL CRITERIA 

 Phase contrast matches magnification 
 Light is adjusted as needed 
 Focus is adjusted as needed 
 Adjust ocular lenses as needed 
 Look through both ocular lenses simultaneously 
 Complete task in timely manner 

SATISFACTORY CRITERIA 
 DEMONSTRATES ABILITY TO CHANGE MAGNIFICATION 
 CAPTURE A CLEAR IMAGE WITH CELL STRUCTURES PRESENT 
 CALIBRATION IMAGE AT CORRECT MAGNIFICATION IS CAPTURED 
 BOTH CAPTURE AND CALIBRATION IMAGE ARE SAVED TO THE COMPUTER DESKTOP WITH 

APROPIATE FILENAMES 
 CORRECT PPE IS WORN 

 MICROSCOPE IS TURNED OFF AFTER USE 

NOTES 
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Procedure  
Introduction: In this activity, you will become familiar with the operation of the microscopes in 
the lab. We have several inverted microscopes, and all of them have the capability for phase 
contrast (great for imaging live cells). An instructor will provide an initial demonstration of how 
to use a microscope and point out any important procedures and tips for each microscope. 
Afterwards, you will image a tissue specimen. For part of your post-lab you will use ImageJ 
software to estimate the cross-sectional area of a particular blood vessel. 

Image Acquisition 

1. After the instructor’s demonstration, decide which objective you will use to image a blood 
vessel on the provided histology slide. 

2. Ensure that the whole internal cross-section is visible in the field of view and the tissue is in 
focus after you snap a picture.  

a. You may have to adjust your objective and field of view. 
3. Make sure you save the picture with a useful name (your last name, microscope objective, 

short description of what it is.  E.g. “Breen_20x_Vein.tiff”) on the lab laptop. 
4. Try to get images of at least 3 blood vessel cross-sections. 
5. Using the same objective, and microscope settings, snap a picture of the calibration slide. 

(Now you have a calibration image, an image of an object with known dimensions).  
a. Make sure you take a note, in your lab notebook, of the units on the calibration slide. 
b. Anytime you use a different microscope or different objective, you’ll have to acquire a 

calibration slide for that specific set-up. 
6. Make sure to also save your calibration image under a useful name. 
7. Include your original slide images in Figure 1-2 below, note down the filenames, and any 

important microscope settings that you used to take the pictures.  

Slide Images 

   

Slide Image Name .tiff .tiff .tiff 

Calibration File Name .tiff .tiff .tiff 

Microscope Settings 
   

Figure 1-2 Images of histology slides, filenames, and microscope settings for each histology slide image. 
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Image Analysis 

We will use ImageJ software to make measurements on the blood vessel you imaged. 

1. If you have not already done so install ImageJ (Windows) or Fiji (Mac)(link and instructions 
are on Canvas or here https://imagej.net/ij/download.html ) 

 

Figure 1-3 ImageJ 1.53t Toolbar 

2. Open the calibration image for your first histology slide in ImageJ by: 
a. File → Open → Select your image file 

3. Select “Straight Line Selections” tool from the ImageJ toolbar (See Figure 1-3 ) 

 

Figure 1-4 Calibration Slide Dimensions. Entire line is 1 mm with each large increment 0.1 mm apart and 
each of the smallest increments are 0.01 mm apart. 

4. Draw a straight line of a known distance on your calibration slide image (See Figure 1-4) 

a. Hint: use the magnifying glass tool on ImageJ toolbar( ) to zoom in on what you 
are measuring to help measure with accuracy 

b. Another hint: take multiple measurements on your calibration slide, if there are 
slight variations take the average of your measurements. If there are large 
variations, check your work and try again.  

5. Measure the straight line by: 
a. Menu Button Analyze → Measure 
b. Your line length is provided in units of pixels in the pop-up results window under 

“Length”. 

https://imagej.net/ij/download.html
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Figure 1-5 Screenshot of setting the scale of an image in ImageJ 

6. Set the scale of your image based on your known dimensions by: 
a. Analyze → Set Scale 
b. As shown in Figure 1-5, enter the pixel distance you measured in step 5 in 

“distance in pixels” box 
c. Enter the known distance of your line 
d. Don’t forget to enter the appropriate units in the “unit of length”! 
e. By selecting the “global” check box, you will apply your calibration to all images 

you open in ImageJ after your calibration. 
f. Select “OK” 

7. Check your calibration by re-measuring your known distance (like in steps 4 and 5) 
a. Note: your line length this time should be given in appropriate dimensions in the 

pop-up results window.  
8. Measure Cross Sectional Area of the vessel lumens captured in your images. 

a. You’ll use two methods to measure lumen area in ImageJ.  

i. Use the “Straight line” tool ( )to take diameter measurements, and 
assume the cross-section is an ellipse, estimate the cross-sectional area of 
your blood vessel using Equation 1-1.  

ii. Use the “Freehand selection” tool ( ) to trace and measure the inside of 
the blood vessel as accurately as you can.  

Before acquiring your results, write a measurable hypothesis in  

b. Table 1-1 below about the results of the different measurement methods. Get 
feedback about your hypothesis from your instructor before you leave. 

c. When you have completed your analysis report your results in your results in Table 
1-3 below. 

STRAIGHT LINE TOOL ANALYSIS: Repeat the measure tools used in steps 4 and 5 to obtain the 

radius dimensions for the lumen in your images. Review Equation 1-1 and Figure 1-7 and show 

your calculations for each image in   
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d. Table 1-2 below. 
i. Hint: Remember your required radius measurements will be 50% of any 

measured diameters. 

e. FREEHAND TOOL ANALYSIS: Use the “Freehand selection” tool ( ) to trace and 
measure the inside of the blood vessel as accurately as you can. Use the Menu 
Button Analyze → Measure. Your lumen area is provided in the pop-up results 
window under “Area”. 

You will need to export and save a screenshot of your traces for each image 

in   
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i. Table 1-2 below. When taking quantitative measurements, it is always 
recommended that exported images have scale bar, please follow the steps 
outlined below to add a scale bar and to flatten and export your image: 

 
Figure 1-6 Screenshot of adding a scalebar to an 

image in ImageJ 

 
ADD SCALE BAR (See  Figure 1-6): 

o Menu Button Analyze → Tools … → Scale 
bar … 

o Adjust Width, Height, Thickness and Font 
Size appropriately 

o Use an upper or lower right or left location 
(do not use “at selection”) 

FLATTEN & EXPORT IMAGE:  

o Menu Button Image → Overlay → Flatten 
o Menu Button File → Export → Image 

 

Equation 1-1. Cross Sectional Area of an Ellipse 
where a is the major radius, b is the minor radius 

and 𝜋 is 3.14159. 

𝐶𝑆𝐴 =  𝑎 × 𝑏 × 𝜋 

 

 

Figure 1-7 Major (a) and minor radius (b) 
illustrated on sample vessel lumen 

 

Table 1-1 Hypothesis and experimental variables for measurement comparison for lumen cross sectional 
area 

Independent Variable(s):  

Dependent Variable(s):  

Control Variable(s):  

Hypothesis:  
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Table 1-2 Cross Sectional Area calculations and screenshots for three images 

 Straight Line Tool 
Calculations 

Freehand Trace Freehand Area 

Sample 

Major Axis: 0.131 mm  

Minor Axis: 0.039 mm  

CSA:  
0.131 * 0.039 * 3.14159 

0.016 mm2 

 

0.015 mm2 

Image 1 Major Axis: _____  

Minor Axis: _____  
CSA:  

  

Image 2 Major Axis: _____  
Minor Axis: _____  
CSA:  

  

Image 3 Major Axis: _____  
Minor Axis: _____  

CSA:  
  

 

Table 1-3. Comparison of vessel lumen cross sectional area between the "Freehand" and "Straight line" 
measurement methods. 

  Freehand Method Straight Line Method p-value 

Cross Sectional Area (mm2) 
Average    

Standard Deviation   
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Post Lab Questions 
We will conclude lab with a guided group discussion on the data your group, and section 

collected. Please take notes on this discussion below within the relevant question areas.  

Hypothesis 

When reviewing your data, and the results of your statistical testing, does is support your 

hypothesis? Please provide reasoning to support your answer 

Is your hypothesis 
supported? 

 

Reasoning  

Data Validity 

Is the data you collected valid? Please provide reasoning to support your answer 

Is your data valid?  

Reasoning  

Data Reliability 

Is the data you collected reliable? Please provide reasoning to support your answer 

Is your data valid?  

Reasoning  

Limitations & Future work 

If you were to conduct this experiment again, what changes would you make? Please provide 

reasoning to support your answer 

Changes  

Reasoning  

 

Post-Lab Checklist: 
 Submit completed procedure and post lab questions (Upload completed pages 1:1-1:8) 
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Module 2 Micropipetting & Dilutions 

Pre Lab-Review 

Pre-Lab Checklist: 
 Complete Lab Safety Training (Upload Certificate to Canvas) 

 Complete CATME Team-Maker Survey 

 Complete B-Me Survey on Canvas 

 Complete Pre-Lab 2 

Pre-Lab 2: Micropipetting & Dilutions 
This pre-lab will be available on Canvas as a quiz with unlimited attempts and no time limit. 

Please use the space below to review and work on your questions before opening the quiz. 

Introductory Video: 

Step one of your pre-lab is watching an informational video on Micropipetting that is less than 10 

minutes long. You can access that video here: https://youtu.be/aSeod1Y5MRc  

Background Information: 

Selecting the appropriate micropipette: The lab is outfitted with several sets of micropipettes.  Each set 

consists of 4 different sizes: P1000, P200, P100, and P10, all color-coded with lab tape, so you know easily if you have 

a whole set. The largest size, the P1000 has a working range of 1000 – 200 μL, and works with the largest size tips.  

The medium size tips fit both the P200, which has a range of 200 – 20 μL and the P100, which has a range of 100-10 

μL.  The smallest micropipette, the P10, uses the smallest tips and has a working range of 10 - 1 μL.  Never try to 

adjust the micropipettes outside of these ranges. Keep in mind, during your micropipette selection, that micropipettes 

are most accurate in the middle of their working range. 

Pipetting technique will affect accuracy: Be sure to use proper 

pipetting technique. Proper technique involves drawing up (aspirating) and 
dispensing (ejecting) the liquid in a smooth motion. Putting the pipette tip 
in the water and quickly releasing the plunger will give you inaccurate 
results—even if your pipette is properly calibrated. In fact, using proper 
pipetting technique will not only increase the robustness (and reliability) 

of your results but will also decrease the wear and tear on your pipette.  

One of the most common problems for the beginner is the tendency of small 
liquid volumes to adhere to the pipette tip rather than dispensing into the 
tube. Never dispense a small volume into thin air. As shown in Figure 2-1 
always dispense into a liquid or onto the wall of a tube so that adhesion will 

draw the expelled liquid off the tip. 

The Weight of Water: The most common way to check your pipette 

accuracy is by weighing water. The density of water is 1 g/mL. This means 
that every microliter (µL) should have a mass of 0.001 g. In other words, 
if your pipette is accurate, the amount of water you dispense will equal 
the amount the water weighs. So, if your pipette is set to 100 µL, then 

the scale should read 0.1 g. 

Figure 2-1 Dispensing small volumes 
from a micropipette 

https://youtu.be/aSeod1Y5MRc
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Question 1: 

Identify the pipetting ranges of the micropipettes we have in the lab: 

 Minimum Volume (μl) Maximum Volume (μl) 
P2   

P10   

P200   

P1000   

 

Question 2: 

What volume (in units of mL) would be pipetted if a P1000 was set in to have 

the digits 050 as shown in Figure 2-2? 

Answer: [            ] mL 

Question 3: 

As part of your lab procedure this coming week you will pipette several volumes 

of liquid as noted in Table 2-1. Fill in Table 2-1. with your chosen micropipette 

and dial readings. 

What is the final total volume you should have based on Table 2-1?  

Answer: [            ] µL 

Using the density of water, estimate the final weight of water that will be in 

your  microcentrifuge tube. Show your work for the estimations. 

Answer: [            ] g 

Show your work here: 

 

Table 2-1 Liquid volumes and corresponding micropipette settings 

Amount of 
water to 

add to tube 
220 µl 7.0 µl 123 µl 0.0183 ml 0.583 ml 197 µl 0.0047 ml 347 µl 

Micropipette 
used (e.g. 
P10, P100) 

       P1000 

Volume 
readout 

  

  

 

  

 

  

 

  

 

  

 

  

 

  

0 

        3 

       4.7 

Figure 2-2 P1000 
Micropipette with 

volume readout set 
to 050 
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Additional Background Information: 

Preparing reagents and solutions is a never-ending task in most laboratories. This is a basic laboratory skill that 
often confuses people at first. Here we present the standard, general approach to computing dilutions and 
concentrations, the Dilution Factor Technique. It is a convenient way of computing dilutions at the bench.  

 
Dilution Factor (DF): The DF is a dimensionless number that unambiguously describes the "strength" of the 

dilution. It is equal to the volume of stock solution used (V1), divided by the total volume of working solution 
produced (V2). In turn, V2 = V1 + the volume of diluent used. The dilution factor also gives the relationship between 
solute concentration in the stock solution (C1) and the working solution (C2). 

The precise relationships are given by: 
 

Equation 2-1 Dilution Factor (DL) where the concentration (C) 
and volume (V) are shown for the stock (1) and working (2) 
solutions. 

𝐷𝑖𝑙𝑢𝑡𝑖𝑜𝑛 𝑓𝑎𝑐𝑡𝑜𝑟 (𝐷𝐹) =
𝐶2

𝐶1
=

𝑉1

𝑉2
 

 
This is sometimes given as:  
 

Equation 2-2 Rearranged Dilution Factor (DL) equation where 
the concentration (C) and volume (V) are shown for the stock 
(1) and working (2) solutions. 

𝐶1 × 𝑉1 = 𝐶2 × 𝑉2 

 
Serial dilutions: A serial dilution is a step-wise series of dilutions, where the dilution factor stays the same for 

each step. It is a sequential set of dilutions in which the stock for each dilution in the series is the working solution 
from previous dilution. In effect, except for the last dilution, each dilution is both a stock and a working solution. 
The DF for the entire series as a whole is the product of the DF's of each individual dilution. 
 

Equation 2-3 Dilution Factor (DF) for a series of three dilutions 

𝐷𝐹 𝑡𝑜𝑡𝑎𝑙 = 𝐷𝐹1 × 𝐷𝐹2 × 𝐷𝐹3 
 
Ordinarily, volumes are chosen to give DF values that are simple powers of ten. This makes it relatively simple to 
remember what you are doing and to perform the dilution calculations in your head. 
 

 
Example: If you have 1.0 ml of bovine serum albumin (BSA) at a concentration of 10 mg/ml. You want 1.0 ml 
of BSA at a concentration of 10 ng/ml. What is the procedure you would use to dilute your sample to 10 
ng/ml?  

 

• DF = C2 / C1 = 10 (ng/mL) / 107 (ng/mL) = 10-6 

• V1 = DF X V2 = 10-6 X 1,000 μL = 10-3 μL 

 

Add 0.01 μL stock to 1.0 mL water. 

 
This is not as straightforward as it appears. Remember that you cannot measure volumes less than 1 μl 
accurately. Instead, you would perform a series of standard dilutions otherwise known as a serial dilution. For 
example, could do a series of three consecutive 10-2 dilutions to reach a total dilution of 10-6. 

 

 

REMEMBER:  

V2 > V1 | C2 < C1 | DF < 1.0  

• A "50-fold [50X]" 

dilution has DF = 1/50 

= 0.02 

• When you add 1.0 ml of 

stock to 4.0 ml of 

diluent, DF = 1/5, NOT 

1/4.  
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Standard Curves: Trypan Blue is a common dye reagent 

used to cell studies.  By measuring the absorbance (the 

amount of light absorbed) of a sample containing Trypan 

Blue at 595 nm and comparing the result to a standard, one 

can determine the dye concentration in a solution. 

Standards can be created by adding a known amount of 

solute (in this case, dye) to a solution. The samples can be 

read in the plate reader to create a standard curve, or 

calibration curve (Figure 2-3). Unknown standards can be 

determined by interpolation. Typically, standards are 

made across a range of concentrations so that the expected 

values of the unknown fall within the range of the known 

standards. 

Question 4: 

As part of your lab procedure this coming week you will prepare a standard curve of trypan blue 

solution. Below you will prepare your calculations for the serial dilution so that the readings of 

the sample can be done in triplicate. 

Serial dilutions can be used to make standards (solutions of a known concentration of some 

solute, like dye). To make a serial dilution, rather than pipetting exact volumes from the stock 

to make each concentration individually, you start with an initial concentration, take a sample 

from that, and dilute it to your next concentration, and so on (See Example on page 2:13).  

On page 2:14, calculate and detail, how you will prepare a series of serial dilutions to get the 

final required standard concentrations. The stock concentration of Trypan Blue is at a 

concentration of 0.1%. Your will need samples at the following concentrations: 0%, 0.0125%, 

0.025%, 0.5% and 0.1%. You will create standards for the concentrations of 0.0125%, 0.025%, and 

0.05%, and use the diluent and stock for the 0% and 0.1% samples respectively. You will need to 

make enough solution for three 100 μL replicates, 330 μL should be sufficient for three 100 μL 

with 10% overage.  

Hint: To help you plan, review the step-by-step serial dilution example below which uses a series 

of 2-1 or 2x dilutions. 

  

y = 30.133x + 0.0572
R² = 0.9991

0.0
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Figure 2-3 Example of a Trypan Blue Standard 
Curve 
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Example: Prepare a series of serial dilutions to create a standard curve for Trypan Blue. Your will need 

samples at the following concentrations: 0%, 0.0125%, 0.025%, 0.5% and 0.1%. The stock concentration of Trypan 
Blue is at a concentration of 0.1%. Plan so that you have 50 μL of each concentration with 10% overage. 

Step 1 Determine the diluent:  
Trypan Blue can be diluted in distilled water. 

 

Step 2 Fill target containers with diluent:  
Required Data: [1] Number of serial dilutions and containers, [2] volume required of each standard, [2] volume 

of diluent per container. 

Concentration (%) 0% 0.1% 0.05% 0.025% 0.0125% 

Dilution Factor 

NA NA 

DF= C2 / C1 
= 0.05% / 0.1% 

= 0.5 or 2-1 

= 2 X or 1:2 

V2= V1/DF  

= 55 / 0.5 μL = 110 μL 

DF= C2 / C1 
0.025% / 0.1% 

= 0.25 or 2-2 

= 4 X or 1:4 

DF= C2 / C1 
0.0125% / 0.1% 

= 0.125 or 2-3 

= 8 X or 1:8 

Volume Diluent 55 μL 0 μL 55 μL 55 μL 55 μL 

Volume Stock 0 μL 55 μL 0.1% 55 μL 0.1% 55 μL 0.05% 55 μL 0.025% 

We will perform three serial dilutions with a DF of 2-1 to produce 55 μL of each standard and use 55 μL of 

diluent in each container 
 

Step 3 Perform the first dilution:  

Place 55 μL of the 0.1% stock solution into Tube 1 which has already contains 55 μL of water. The resulting 

volume is Tube 1 is 110 μL with a concentration of 0.05%. 

 
Step 4 Perform the second dilution:  

Place 55 μL of the well mixed 0.05% solution into Tube 2 which already contains 55 μL of water. The 

resulting volume is Tube 2 is 110 μL with a concentration of 0.025%. 

 
Step 5 Perform the last dilution:  

Place 55 μL of the well mixed 0.025% solution into Tube 3 which already contains 55 μL of water. The 

resulting volume is Tube 3 is 110 μL with a concentration of 0.0125%. 
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Question 4 continued … 

Determine the diluent: _________________ 
What diluent is appropriate for Trypan Blue Dye? 

What is the dilution factor for each required concentration: 
DF=C2/C1 

Concentration (%) 0% 0.1% 0.05% 0.025% 0.0125% 

Dilution Factor  
 
 
 

 

   

How many serial dilutions need to be completed: _________ 
How many serial dilutions are required to reach your desired concentrations? 

 
 
 

What volume each concentration is needed: _________ μL 
How many replicates, at what volume, with how much overage? [replicates*volume+overage] 

 
 
 

How much diluent needs to be placed in each container: _________ μL 
V2= V1/DF, the working solution V2 includes the diluent and the stock solution.  

Concentration (%) 0% 0.1% 0.05% 0.025% 0.0125% 

Volume Diluent  
 
 
 

 

   

Complete Serial Dilutions Table 2-3: 

Table 2-2. Serial Dilutions Table for Example on page 2:13. A threefold serial dilution of 0.1% stock 
Trypan Blue dye to 0.05, 0.025 and 0.0125% stock to produce a total volume of 50 ml with 10% overage. 

Concentration (%) Source Volume Stock (μL) Volume Diluent (μL) Final Volume (μL) Dilution Factor 

0 Diluent 0 220 55 0 0 0 

0.1 Stock 110 0 55 20 1 1x 

0.05 Tube 1 55 55 55 2-1 0.5 2x 

0.025 Tube 2 55 55 55 2-2 0.25 4x 

0.0125 Tube 3 55 55 110 2-3 0.125 8x 
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Table 2-3 Serial Dilutions Table for a threefold serial dilution of 0.1% stock Trypan Blue dye to 0.05, 
0.025 and 0.0125% stock to produce a total volume for three 100 ml replicates with 10% overage. 

Concentration 
(%) 

Source 
Volume Stock 

(μL) 
Volume Diluent 

(μL) 
Final Volume 

(μL) 
Dilution Factor 

0 Diluent     

0.1 Stock     

0.05 Tube 1     

0.025 Tube 2     

0.0125 Tube 3     

 

Module 2 Lab Procedure 

Introduction: 
Depending upon the procedure being performed, cell engineering experiments can utilize a variety 

of volumes of biological samples and reagents, ranging from several hundreds of liters to very 

small microliter (µL) volumes. Pipetting is a critically important technique in life science 

experiments to ensure accurate experimental results. For example, small differences in drug 

concentrations can make a huge difference in cell engineering experiments. 

Learning Objectives 
1. Identify the components of a micropipette 

2. Accurately pipet different microliter volumes using a micropipette 

3. Practice serial dilutions and create a standard curve generated through 
spectrophotometry to check pipetting accuracy 

Materials 
Equipment Software Materials Misc. 

Phase Contrast Microscope Gen5 Aliquot of 0.1 % Trypan Blue Dye Absorbent pad 

Spectrophotometer  Aliquot of mystery Trypan blue sample Transparent 96-well plate 

Electronic balance  20 ml of Deionized (DI) water 1.5 ml microcentrifuge tubes 

   Small beaker 

Important Terms 
Microliter (μL)  

Milliliter (mL)  

Percentage error  

Regression Equation  

Standard Curve  

R2 value  

Intercept  

Safety: 
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We are using a potentially toxic material—Trypan Blue-- so gloves, lab coat, and goggles are 

necessary to protect your skin and clothing.  

Teamwork: 
You may work in groups, but each individual student should complete the pipetting exercises 1 
and 2 independently. Meaning, everyone should test and practice their pipetting skills. 
Procedure Part 3 should be completed in pairs.   



  BME 3181: BME Core Lab II 
 
 

Module 2 Page 2:3 

Setup: 

 
Figure 2-4. A P1000 micropipette is shown with parts labelled. The pipette is shown with a pipette tip 
attached, set a maximum volume (1000 µl).  

 
1 Set the micropipette volume readout to the required volume by adjusting the thumb wheel. 

2 Place a clean pipette tip on the micropipette. 

3 Press the plunger down to the first stop.  

4 Hold the plunger down while placing the pipette tip just beneath the surface of the liquid. 
5 ASPIRATION: Slowly release the plunger to draw sample into the pipette tip  

6 
DISPENSING: Deliver the sample by slowly pressing the plunger to the first stop, pause, then continue to 
depress the plunger to the second stop and expel any remaining sample. Do not release the plunger until 
the tip is out of the sample container. 

7 Discard the tip in the waste cup by pressing the ejector button. 

Figure 2-5 Steps 1 - 7 of using a micropipette to transfer fluid.  
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BME3181: Micropipetting Practical 

1. Obtain a clean 1.5 mL microcentrifuge tube and weigh it on the balance. 

2. Label the microcentrifuge tube with its mass. 

3. Review the volumes of water listed in the first row of Table 1, decide on your 
micropipettes and volume readouts and complete Table 1  

4. Add the volumes of water listed to the microcentrifuge tube. 

Table 1: Water added and corresponding micropipette settings. 

Amount of 
water to add 

to tube 
220 µl 7.0 µl 123 µl 0.0183 ml 0.583 ml 197 µl 0.0047 ml 347 µl 

Micropipette 
used 

        

Volume 
readout 

                        

        

        

Please note these volumes will be randomized and will vary for each lab practical. 

FOR INTRUCTOR USE 

Table 2: Weights and volumes of microcentrifuge tube 
Estimated 

Volume of 
water (µl) 

Estimated 

mass of water 
(g) 

Actual mass 

of empty 
tube (g) 

Actual mass 

of tube + 
water (g) 

Actual mass 

of water (g) 

Actual volume of 

water (µl) 
 

Pipetting % 

Error 

       

EXCEPTIONAL CRITERIA 

 Correctly holds micropipette in one hand 

 Only uses thumb on plunger 

 Plunger is depressed to first stop before tip is placed in fluid  

 Plunger speed is slow and controlled 

 Plunger is depressed to second stop when dispensing fluid 

 Correctly discards tips 

 Uses benchtop space efficiently 

SATISFACTORY CRITERIA 

 PIPETTING ERROR < 10% 

 CORRECT PPE IS WORN 

NOTES 
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Procedure Exercise 1 (Quick Test) 
Here are two quick tests of your independent ability to operate the micropipettes. 
1.1. Use a P1000 to transfer 0.5 mL of DI H2O to a microfuge tube. 

a. Set the P200 to 100 μL and aspirate the entire 0.5 ml in five separate increments. 
b. Were you able to withdraw exactly five 100 μL quantities? 

 

 

 
1.2. Use a P100 to add 0.05 mL of DI H2O to a microfuge tube. 

a. Set the P10 to 10 μL and aspirate the entire 0.05 ml in five separate increments. 
b. Were you able to withdraw exactly five 10 μL quantities? 

 

 

 

Procedure Exercise 2 (Pipetting Challenge) 
The most common way to check your pipette accuracy is by weighing 
water. The density of water is 1 g/mL. This means that every microliter 
(µL) should weigh 0.001 g. In other words, if your pipette is accurate, the 
amount of water you dispense will equal the amount the water weighs. 
So, if your pipette is set to 100 µL, then the scale should read 0.1 g. 

2.1. The data for Table 2-4 should be drafted from your pre-lab. 
Consult with your teammates and instructors to finalize the data in 
Table 2-4. 

2.2. What is the final total volume you should have based on Table 2-4? 
Put this number in Table 2-5 under “Calculated Final Volume of 
Water”. 

2.3. Using the density of water, estimate the final weight of water that will be in your 
microcentrifuge tube. Note under “Estimated Final Weight of Water”. Show your work for 
the estimations. 

CHECK THE NUMBERS in Table 2-4 and Table 2-5 WITH YOUR LAB INSTRUCTORS 
2.4. Obtain a clean 1.5 mL microcentrifuge tube and weigh it on the balance. Note the mass in 

Table 2-5. 
2.5. Add the amounts of water listed in the first row of Table 2-4, to the microcentrifuge tube 

that you weighed (carefully note the volume units). If required update Table 2-4 with the 
micropipette you used, and the digit setting on the micropipette.  

2.6. Now weigh your microcentrifuge tube with water. Note in Table 2-5.  
2.7. Does this match the volume of water you can “eyeball” with the graduation on the 

outside of the tube? 

 

Amount of 

water to add 

to tube

Micropipette 

used (e.g., 

P1000, P10, 

etc)

0

3

3.5

Setting on the 

micropipette 

dial

335 μL

P1000
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2.8. Analyze your pipetting technique by calculating the percentage error of your measured 
(actual) value vs your correct known value of the calculated value of water volume, place 
your value in Table 2-5. Please review Equation 1-1 for calculating percentage error. 

Equation 2-4 Calculation of percent error 

𝑃𝑒𝑟𝑐𝑒𝑛𝑡 𝐸𝑟𝑟𝑜𝑟 =  
|𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑑 −  𝐶𝑜𝑟𝑟𝑒𝑐𝑡|

𝐶𝑜𝑟𝑟𝑒𝑐𝑡
 × 100 

 

Table 2-4 Liquid volumes and corresponding micropipette settings for Exercise 1 

Amount of 
water to 

add to tube 
220 µl 7.0 µl 123 µl 0.0183 ml 0.583 ml 197 µl 0.0047 ml 347 µl 

Micropipette 
used (e.g. 
P10, P100) 

        

Volume 
readout 

 

 

  

 

  

 

  

 

  

 

  

 

  

 

  

 

         

        

 

Table 2-5 Masses and volumes of microcentrifuge tube at various stages of Exercise 1 process 

[Correct] 
Calculated 
Volume of 

water (µl) 

[Correct] 
Estimated 

mass of water 

(g) 

[Measured] 
Actual mass 

of empty 

tube (g) 

[Measured] 
Actual mass 

of tube + 

water (g) 

[Measured] 
Actual mass 
of water (g) 

[Measured] 
Actual volume of 

water (µl) 
Pipetting % 

Error 

       

 
Show your work here: 
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Procedure Part 3 (Serial Dilutions & Standard 
Curve) 
Please complete procedure part 3 in pairs. Preparing accurate standard curves is another 
necessary skill and requires accurate pipetting for 
accurate results. 

Serial Dilution & Standards Data Collection 

3.1. Prepare your Trypan Blue standards through a 
serial dilution in 1.5 ml centrifuge tubes, based 
on your calculations and plan in your pre-lab 
assignment.  

3.2. Prepare 100 μL samples in triplicate (that 
means 3 x 6 different wells. That is, 5 
standards plus 1 mystery sample) on a clean 
transparent 96-well plate. See example in 
Figure 2-6. 

a. Prepare all your samples in wells near 
each other, we recommend running 
triplicates in the same row next to each 
other with standards along the columns. 

b. You prepared more than the required 
volume for overage, you should have 
some sample left over in your sample tube (if not, check your pipetting technique).  

c. In another set of wells, pipette the mystery sample (unknown) into your well plate. 
3.3. Take note in the blank well plate layout in Figure 2-7 of which standards and samples 

are in which well. 
 

3.4. Using the spectrophotometer plate 
reader, measure absorbance of the 
samples at a wavelength of 595 nm. 

Please note down the make and model of 

the spectrophotometer plate reader. 

 

Please note down the software used on 

the spectrophotometer. 

 

Please note down the settings used to 

measure absorbance. 

 
  

 

 

Figure 2-6 Layout of a 96-well plate for 5 
standards and a mystery sample in 
triplicate. 

Figure 2-7 Blank 98 well plate layout 
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Standards Data Analysis 

3.5. From the data collected in step 3.4 
please create a standard curve.  

a. Label your x and y axes. 
b. Provide a caption for your Figure. 
c. Display the equation and R2 value 

on the graph. 
d. Please calculate standard deviations 

for your triplicate samples and 
indicate standard error with error 
bars on your standard curve. 

 

 

 

3.6. Please describe your standard curve: 
Please report the equation, the R-value, the intercept and if the curve is linear. 

 

 

3.7. Use this information provided in Step 3.6 to calculate and report the concentration of 
the mystery sample. 

Show your work here: 
 
 
 
 
 
 
 
 

Concentration of mystery sample:  

 

Post-Lab Checklist: 
 Submit completed procedure and post lab questions (Upload completed pages 2:15-2:8) 

  

Place Figure here 

Insert Caption here 
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Module 3 Fluorescence 

Pre Lab-Review 

Pre-Lab Checklist: 
 Submit Pre-Lab 3 (Complete Quiz on Canvas) 

Pre-Lab 3: Fluorescence 
This pre-lab will be available on Canvas as a quiz with unlimited attempts and no time limit. 

Please use the space below to review and work on your questions before opening the quiz. 

Introductory Video: 

Step one of your pre-lab is watching two informational videos on Fluorescence [09:32] and 

Fluorescent Microscopy [05:41]. You can access the videos here: 

• Fluorescence as a Biological Tool [09:32] https://youtu.be/rE42zZ-3wNo  

• Fluorescent Microscopy [05:41] https://youtu.be/PE3XBYebtZQ  

Question 1: 

What is the difference between excitation and emission, with regards to a fluorophore? 

 
 

Question 2: 

Why is it necessary to keep fluorescently stained samples protected from light? Describe how 

light affects fluorescent stains. A useful resource to answer this question is cited here:Ettinger, 

A., & Wittmann, T. (2014). Fluorescence live cell imaging. Methods in cell biology, 123, 77–94. 

https://doi.org/10.1016/B978-0-12-420138-5.00005-7 

 
 

Question 3: 

Review the next section of your lab book at the procedure for your fluorescence lab. 

Write a measurable hypothesis based on the lab procedure. 

 
 

Describe how you will analyze this hypothesis: 

 
 

https://youtu.be/rE42zZ-3wNo
https://youtu.be/PE3XBYebtZQ
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Question 4: 

Calculate the amount of TRITC-conjugated phalloidin and DAPI solution necessary for 6 wells. 

You will need at least 200 μL of total solution per well, plus ~10% overage. You can mix the 

TRITC-phalloidin and DAPI in the same solution. 

• You will add the TRITC-phalloidin at a ratio of 1:250 in PBST-T solution. 

• You will add DAPI (in the same solution) at a ratio of 1:500 in PBST-T solution. 

 

What volume of TRITC-phalloidin do you need? [______] μL 

What volume of DAPI solution do you need? [______] μL 

What volume of PBST-T solution do you need? [______] μL 

 

Show your work here: 

 

 

 

 

 

 

 

 

 

 

 

Please upload a copy of this page to your canvas quiz to show your work. 
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Module 3 Lab Procedure 

Introduction: 
You will be given a 48-well plate with cultured NIH 3T3 fibroblasts that have been fixed and 

permeabilized. You will use TRITC-conjugated phalloidin to fluorescently stain the actin 

cytoskeleton. Phalloidin is a toxin derived from a mushroom that preferentially binds to 

filamentous actin (f-actin) in permeabilized cells. This phalloidin has a TRITC fluorophore attached 

to it allowing you to visualize the cytoskeleton of the cells. DAPI is a fluorescent nucleic acid stain 

that binds strongly to A-T-rich regions in DNA, allowing you to visualize the nucleus of the cells. 

Learning Objectives 
1. Use a fluorescent microscope to obtain images of cells for qualitative and quantitative 

analysis 

2. Use a plate reader to analyze fluorescence quantitatively. 

Materials 
Equipment Software Materials Misc. 
Phase Contrast Microscope Gen5 TRITC-conjugated phalloidin fluorophore Absorbent pad 

Fluorescence Microscope AmScope PBST-T (0.05% Tween + 0.5% Triton-x in PBS) Foil 

Spectrophotometer ImageJ DAPI fluorophore Kimwipes 

Shaker  Fixed NIH 3T3 fibroblast cells on a 48-well plate 1.5 ml centrifuge tubes 

  1X PBS solution Serological pipettes and 
micropipettes 

    

Important Terms 
Actin Cytoskeleton  

Cell Nucleus  

Florescence  

Absorbance  

Excitation  

Emission  

PFA  

Positive Control  

Negative Control  

Safety 
You need to protect your skin and eyes from several chemicals today. Wear goggles, gloves, 

closed toe shoes, and a lab coat.   
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Prelab Notes: 
Use this space for making notes on any prelab calculation or question errors. 
 

Independent Variable(s):  

Dependent Variable(s):  

Control Variable(s):  

Positive Control Condition(s):  

Negative Control Condition:  

Hypothesis:  

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 

 

Demonstration Notes: 
Use this space for making notes on your instructor demonstration. 
 

What is power washing and how will you avoid it? 

 

How will you avoid the cells drying out? 

 

Other notes: 
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Procedure Part 1a Remove PFA & Rinse cells 
1.1. Visualize the cells under a phase contrast microscope. Select 6 wells that you will 

stain.  
a. You are limited to ~6 experimental wells due to limited reagents 
b. Select 3 wells with cells at low density and 3 wells with high cell density. 

**Note: Your instructional team will prepare negative and positive controls for you. 
1.2. Remove PFA from chosen wells 
1.3. Gently rinse the cells in the 48-well plate with 1X PBS solution. 

a. This involves placing 200 μL of PBS into each well and rising the well by moving the 
PBS in and out of the well with your pipette.  

b. Please review your notes from your instructor’s pre-lab demonstration. 

• Important: Be careful not to “power wash” the cells with PBS. To help avoid 
this, dispense the PBS along the wall of the well rather than directly on the 
cells attached to the bottom of the well. 

• Important: Do not let the cells dry out at any point in the procedure. 
1.4. Remove PBS and repeat step 1.3 to wash a second time. 

 

Procedure Part 1b Prepare & Apply Fluorescent 
Stain 

1.5. Make the DAPI/TRITC-phalloidin/PBST-T solution. 
a. Use the calculated volumes of TRITC-phalloidin, DAPI, and PBST-T from your pre-

lab. 
b. Protect the TRITC-phalloidin solution from light. 

1.6. Visualize the cells under a phase contrast microscope to ensure cells are still 
intact. 

1.7. Remove the PBS on the plate and add 200 μL of the TRITC-phalloidin to each of the 
6 wells containing cells in the cell culture plate.  

1.8. Let sit for 30-45 minutes, protected from the light, on a shaker.  
Note the make and model of the shaker you used here: 

 

Note the exact incubation time here: [_________] minutes 

Procedure PART 2a Fluorescent Microscopy 
2.1. After the ~45 minute incubation period, remove the TRITC-phalloidin solution on 

the well-plate and wash with PBS several times. 

2.2. Cover the stained wells with PBS to prevent the cells from drying out. 

2.3. Wipe the bottom of the well plate with Kimwipes or paper towel to remove any 

debris or smudges. 

2.4. Take multiple images in different fields of view using the TRITC filter to observe 

the fluorescently stained cytoskeleton. 
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a. Make sure to get at least three images of each confluence at a consistent 

magnification 

b. When naming files, include details of your team, well location, confluence and 

magnification e.g. Team1_A1_low_4x.tif 

2.5. Don’t forget to get an image of your calibration slide 

Please note down the name, make, and model of the microscope used. 

 

Please note down the software used to save images from the microscope. 

 

 

2.6. Save pictures on your USB or One Drive for analysis. 

Please keep track of the image filenames below: 

High Confluence filenames Low Confluence filenames Calibration filenames 
.tif  .tif  .tif  
.tif .tif .tif 
.tif .tif .tif 

Procedure PART 2b Spectrophotometry 
2.7. For a quantitative assessment of the fluorescently stained wells, read the 

fluorescent intensity on the plate reader 

a. Use the Costar 48-well plate, without a lid. 

b. Read with the RED (TRITC) filter. 

Please note down the make and model of the spectrophotometer plate reader. 

 

Please note down the software used on the spectrophotometer. 

 

Please note down the settings used to measure fluorescent intensity. 

 

 

2.8. Save your data on your USB or One Drive for analysis. 

2.9. You will present this data in a table as part of your post lab questions 
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Procedure PART 3 Quantifying Fluorescent 
Micrographs 
Use ImageJ software to make measurements on the cells that you imaged. If there isn’t enough 
time in lab, this can be done at home after you have downloaded ImageJ (see the link on 
Canvas). 
If your staining wasn’t successful, you can analyze the sample images provided on Canvas 
instead. 

SET THE SCALE.  
If needed review Module 1 for reminders on the basics of ImageJ. 

3.1. Open a calibration image in ImageJ 

3.2. Select “Straight Line Selections” tool from the ImageJ toolbar (See Figure 1-3 ). 
3.3. Draw a straight line of a known distance on your image  
3.4. Set the scale of your image based on your known dimensions 
3.5. To check the calibration by re-measuring the straight line 
3.6. You will include sample images of both confluency conditions and stains as part of 

your post lab questions, make sure they include a scale bar. 

MEASURE CELL AREA. 

3.7. Obtain dimensions of unknown areas of your cell images. 
a. Open one of your fluorescent images.  

b. Use the “Freehand selection” tool (See Figure 1-3 ) to trace the outline of several of 
the cells in your image 
i. Do this as accurately as you can (it doesn’t 

have to be perfect). 
ii. Press “t” to add traces to your Region of 

Interest (ROI) Manager  

• In your ROI Manager check the boxes 
for “Show All” and “Labels” to ensure 
all traces are visible on your sample 

Add a screen shot of your final image with 

all traces, for each image to RECORD 

FLUORESCENCE. 
iii. Table 3-1. 

• Don’t forget to add a scale bar and 
flatten your image before saving 
(guidance on this is available Step 8.e.i 
in Module 1) 

• A Sample image is available in ## 
 

Figure 3-1 NIH 3T3 fibroblast cells stained 
with TRITC-conjugated phalloidin which 
have been outlined and labelled in 
ImageJ. 
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c. In the ROI Manager, click → Measure to quantify the area of each trace in your 
freehand selection. 

Record average cell area across all traces for each sample and note it in RECORD 

FLUORESCENCE. 

i. Table 3-1. 
d. Repeat these steps for each image 

i. You will calculate and record average cell area across all samples and will 
present this data in a table as part of your post lab questions 

MEASURE RELATIVE FLUORESCENCE. 

3.8. In ImageJ, open the original untraced image and convert to gray scale 
a. Image→Type→RBG 
b. Image→Color→Make Composite 
c. Image→Color→Channels Tool 

i. Select Greyscale from the dropdown menu 
3.9. Set your measurements 

a. Analyze → set measurements 
b. Make sure “integrated density” is checked, this is a report of arbitrary units of 

fluorescence 
c. Click “measure” 

3.10. For each image you have taken, use the “IntDen” value as a measure of the total 
fluorescence intensity in arbitrary units (a.u.).  

Record fluorescence intensity for each image and note it in RECORD FLUORESCENCE. 

a. Table 3-1. 
i. Repeat these steps for each image 
ii. You will present this data in a table as part of your post lab questions 
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RECORD FLUORESCENCE. 

Table 3-1 Display of micrograph data of cell area (mm2) and relative fluorescence (a.u.) for three 
samples of high and low confluence wells. 

 Low Confluence High Confluence 

#1   

Cell area:  Cell area:  

IntDen  IntDen  

#2   

Cell area:  Cell area:  

IntDen  IntDen  

#3   

 Cell area:  Cell area:  

 IntDen  IntDen  
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Module 3 Post Lab Questions 
Please answer each of the following questions and upload to your assignment dropbox on Canvas. 

Question 1 

Please include the Fluorescent Microscopy data, presented according to your hypothesis: 

a) Include one Figure which display at least two samples’ images for the TRITC stain 

b) Include one Table with data for average cell area 

i. Include mean and standard deviation data for both high- and low-density wells 

ii. Include results of statistical testing comparing confluence 

c) Include one Table with data for relative florescence for the TRITC stain 

i. Include mean and standard deviation data for both high- and low-density wells 

ii. Include results of statistical testing comparing confluence 

Question 2 

Please include the Spectrophotometry data, presented according to your hypothesis 

a) Include one Table with data for relative florescence for high- and low-density wells for 
the TRITC stain 

i. Include mean and standard deviation data for both high- and low-density wells 

ii. Include results of statistical testing comparing confluence 

Question 3 

Please discuss the following: Do the quantitative results from the plate reader validate your 

quantitative results from the microscope image analysis?  

Post-Lab Checklist: 
 Document and submit completed procedure (Upload completed procedure page 3:1-3:7) 

 Complete and submit Module 3 post lab questions (See Page 3:8) 

 



  BME 3181: BME Core Lab II 
 
 

Module 4 Page 4:A 

Module 4 Aseptic Technique & Cell Passaging 

Pre Lab-Review 

Pre-Lab Checklist: 
 Submit Pre-Lab 4 (Complete Quiz on Canvas) 

Pre-Lab 4: Aseptic Technique & Cell Passaging 
This pre-lab will be available on Canvas as a quiz with unlimited attempts and no time limit. 

Please use the space below to review and work on your questions before opening the quiz. 

Introduction to Aseptic Technique: 

Disinfection 

It is common practice to use a disinfectant such as 70% ethanol or 10% bleach to decontaminate work 

surfaces and equipment (e.g. BSCs, micropipettes, etc.). This should be done before and after protocol 

execution, particularly when working with cell cultures. Both solutions are prepared in squirt bottles. 

Bleach offers advantages of being a broad-spectrum disinfectant; however, the solution can be toxic or 

corrosive. Ethanol is relatively fast acting and nontoxic; however, solutions can catch fire if near high-

heat sources. Both disinfectants can be dangerous if splashed in the eyes. 

Other methods to prevent microbial contamination in the labs are used. Germicidal UV lamps are 

equipped in biosafety cabinets (more detail below) to sterilize cabinet surfaces. Autoclaves can be used 

to sterilize liquid medium, containers, and supplies such as micropipette tips and microcentrifuge tubes. 

These are usually marked with autoclave tape, which has stripes that turns a dark brown color after they 

have been autoclaved. If you see striped autoclave tape on any materials, you may assume that it is 

sterile and must be kept sterile. If you accidentally contaminate these items, remove the striped tape to 

signify it is no longer sterile.  

Preparing the Biosafety Cabinet 

Use the following procedures to maintain the best conditions: 

• Turning on the BSC (when needed). If the fan is off and the sash is closed, the BSC must be 
properly vented and disinfected before use. Raise the sash, the BSC will automatically turn on the 
light and start the blower. If the sash is lifted too high or pulled to low, and alarm will sound. 
Activate the blower and wait at least 15 minutes to allow airflow to equilibrate before use. 
Particulate accumulated within the cabinet will be removed by the HEPA filter. 

• Disinfecting the BSC. Ensure that shirt sleeves are confined and remove jewelry from wrists. 
Wear nitrile gloves and spray both hands with 70% ethanol, rubbing hands together to spread the 
alcohol evenly (gloves should be visibly wet at first). Spray the interior of the cabinet with ethanol 

and use lab tissues to wipe down the work surface. 

• Arrange necessary items in the BSC. All items must be disinfected with 70% ethanol before being 
moved into the BSC. For each item that will be used in the BSC, spray the surface with 70% 
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ethanol and wipe with a lab tissue. Move item into the BSC (ethanol will evaporate quickly). 
Position the items around the perimeter of the cabinet surface. Do not block your primary work 
surface, which is in the middle, and do not block the air intake grill.  

• Working in the BSC. Sit Comfortably so that your arms can move freely. Do not put your elbows 
on the air intake grill as this will block airflow and increase the risk of contamination. Minimize 

the number of times you remove your hands from inside the cabinet while working. Assemble all 
required reagents and consumables inside the hood before beginning work. 

Introductory Videos: 

Please review two informational videos on Tissue Culture [12:00] and Cell Counting [05:01]. You 

can access the videos here: 

• Aseptic Technique and Cell Passaging [12:00]: https://youtu.be/zpmPFOFGhiQ  

• Cell Counting with a hemocytometer [05:01]: https://youtu.be/WWS9sZbGj6A  

Introductory to Cell Counting: 

In the LabXchange video above on cell passaging, the demonstration dilutes the cells on a 1:20 ratio. 

Because our cells are fresh out of cryo we want to count our cells to make sure we are re-seeding at an 

appropriate concentration. To do this we will use a hemocytometer. 

Using a Hemocytometer: A hemocytometer is 

used to calculate the number of cells growing 

in a culture so that you can transfer a desired 

cell density into a new culture flask or 

experiment. As shown in Figure 4-1Error! 

Reference source not found., a 

hemocytometer has two separate sample 

introduction points, each of which enters a 

separate counting chamber. The counting 

chambers are covered by a glass cover slide 

spaced 0.1 mm above the chamber bottom. You 

will inject 10 μL of cells suspended in medium 

through one of the sample induction points into 

a counting chamber. 

There is a grid inside each counting chamber 

like the grid shown in Figure 4-1. The grid is 

divided into several smaller boxes. You will 

count your cells using the 5 boxes in the top 

left, top right, center, bottom left, and bottom right. These boxes are each 1mm2 - one box is magnified 

for you. You will count the number of cells present within each lettered square. Include cells touching 

the gridlines along the top and left border but omit cells touching the gridlines along the bottom and 

right border (as shown). 

  

Figure 4-1 Illustration of counting cells using a 
hemocytometer 

https://youtu.be/zpmPFOFGhiQ
https://youtu.be/WWS9sZbGj6A
https://youtu.be/zpmPFOFGhiQ
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Question 1: 

Count the number of cells in the hemocytometer grids shown in the image below: 

 

Show your work here: 

 

 

 

 

 

Please upload a copy of this page to your canvas quiz to show your work. 

Number of cells  
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Question 2: 

Using the number of cells you calculated above, determine the cell density (number of cells per 

milliliter) in your sample. 

Hint: You will need to calculate the total volume contained within the five red squares. 

Remember, 1 cm3 = 1 mL 

Show your work here: 

 

 

 

 

 

 

Cell Density (cells / ml)  

 

Question 3: 

Given your calculated cell density, how many milliliters of medium should you use to resuspend 

your solution so that you have 1.0 x 104 cells/mL? 

For this calculation you will use Equation 2-1 the C1*V1= C2*V2 method covered in Module 2 page 

2:11 

C1 = concentration of provided solution [answer to Question 2] 

V1 = volume of provided solution [4 ml see step 1.13 in your procedure] 

C2 = desired concentration [4.0 x 103 cells/mL] 

V2 = volume for resuspension [unknown] 

Show your work here: 

 

 

 

 

 

Please upload a copy of this page to your canvas quiz to show your work. 

Resuspension Volume (ml)  
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Question 4: 

Review the next section of your lab book at the procedure for your aseptic technique and cell 

passaging lab. 

What is the independent variable being investigated in this experiment. 

 
 

Question 5: 

Review the next section of your lab book at the procedure for your aseptic technique and cell 

passaging lab. 

One possible dependent variable we could measure for our experiment is cell confluence. Based 

on your experience in ImageJ and the knowledge gained from your videos from this prelab, how 

could we quantify cell confluence. 
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Module 4 Lab Procedure 

Introduction: 
Passaging of cells is used to expand cells (give them more area to grow so that they can multiply) and to 

replate cells in different dishes to be used in experiments.  Different cell types require different rates of 

passaging and cell density to thrive.  Some cell types proliferate quickly while other more slowly.   

Typically, 3T3 fibroblasts, the cells you will be using in your experiments, are grown on a dish until ~80% 

confluence. Confluence is an estimate of the area covered by adherent cells on the cell culture surface.  

If cells are at 100% confluence, that means there the dish is completely covered with cells in a 

monolayer. 100% confluence tends to be too crowded for most cell types and will prevent cells from 

proliferating further. For this reason, it is important to carefully plan cell density and plating 

experiments. 

Learning Objectives 
1. Operate a phase contrast microscope to obtain images of cells for qualitative and quantitative 

analysis 

2. Use a hemocytometer to quantify cell density 

3. Use sterile procedures to passage cells 

Materials 
Equipment Software Materials Misc. 
Phase Contrast Microscope AmScope T-12 culture flask with NIH 3T3 fibroblast cells 15 ml centrifuge tubes 

48-well plate (sterile, 
tissue culture treated) 

ImageJ Modified Essentials Medium (MEM) supplemented with 
10% Calf Bovine Serum (CBS) and 1% antibiotic-
antimycotic (MEM+10% CBS+1% anti-anti) 

Sterile Serological 
pipettes and 
micropipettes 

C-chip disposable 
hemocytometer 

 Modified Essentials Medium (MEM) supplemented with 
0.5% Calf Bovine Serum (CBS) and 1% antibiotic-
antimycotic (MEM+0.5% CBS+1% anti-anti) 

Kimwipes 

  0.05% trypsin with ethylenediaminetetraacetic acid 
(EDTA) 

 

  Sterile Phosphate buffered saline (PBS)  

Important Terms 
BSC  

Media/Medium  

PBS  

Trypsin  

Incubator  

Adhere  

Aspirate  

Centrifuge  

Seed  

Pellet  

Live Dead Assay  

Confluence  
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Safety 
• You need to protect your skin and eyes from several chemicals today. Wear goggles, 

gloves, closed toe shoes and a lab coat. 

• Dispose of anything disposable exposed to the cells/protein in the biohazard box. 

• Clean any glassware exposed to the cells/protein with bleach before cleaning detergent 

• Use 70% ethanol to disinfect all surfaces after your experiments 

• Keep all cells and related solutions sterile and inside the biosafety cabinet using aseptic 
technique 

Hypothesis 
Today we will start a two week experiment where we will measure and compare viability, for 

cells seeded in 10% MEM and 0.5% MEM. 

What is your Hypothesis for this experiment. 

Independent Variable(s):  

Dependent Variable(s):  

Control Variable(s):  

Hypothesis:  

Demonstration Notes: 
Use this space for making notes on your instructor BSC demonstration. 
 

How does your instructor prepare the BSC? 

 

What equipment does your instructor use to aspirate waste in the BSC? 

 

Other notes: 
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Procedure 
Materials Preparation 

1.1. Warm Materials 

a. Make sure you label (e.g. put your initials on) your groups reagent aliquots 

b. Warm your groups’ aliquots of PBS and cell medium in a water bath to 37°C.  

c. Let Trypsin warm to room temperature. 

Please note down the make and model of the water bath. 

 

1.2. While your reagents are warming: 

a. Review the protocol again. 

b. Prepare the BSC (wipe down with ethanol and arrange any necessary materials) 

Please note down the make and model of the Biosafety Cabinet. 

 

c. Take an image with a phase contrast microscope at 4x magnification to record the cell 
confluence in the original cell culture vessel.  

d. Save pictures on your USB or One Drive for analysis. When naming files, include details of 
your team, image purpose and magnification e.g. Team1_InitialConfluence_4x.tif 

Please note down the name, make, and model of the microscope used. 

 

Please note down the software used to save images from the microscope. 

 

Please keep track of the image filenames below: 

Initial Confluence filenames Calibration filenames 
.tif  .tif  

 

Passaging of Cells 

1.3. In the BSC, carefully remove old medium from culture flask using a glass pipette and 
vacuum 

1.4. Gently pipette ~2 mL of PBS into the flask. Lightly tilt the flask left and right to wash the 
entire cell culture surface gently. 

1.5. Remove PBS with a glass pipette and vacuum (be careful not to scrape the cells) 

1.6. Pipette 1.5 mL of Trypsin into the flask. Start a timer once the trypsin is placed on the 
cells. To preserve cell life, we need to prevent cell exposure to trypsin solution for longer 
periods (≥10 min) 

1.7. Close flask and place in incubator for 1-5 minutes to allow cells to lift. 

Note the make and model of the incubator you used here: 

 

Note the exact incubation time here: [_________] minutes 
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1.8. Remove flask from incubator and observe under a microscope. If the cells are still 
adhering to the flask bottom, tap the flask against your palm or edge of the microscope base 
to dislodge the cells. If the cells are still adhering return the flask to the incubator for a few 
minutes. Repeat until all the cells are detached. Be careful not to let the Trypsin sit on the 
cells for more than 10 minutes 

1.9. Add 1.5 mL of fresh medium (use 10% CBS medium, which includes serum which will 
deactivate trypsin) for a total of 3.0 mL of cell suspension 

1.10. Divide your 3.0 mL cell suspension into two equal volumes (1.5 mL of each) and put them 
into two separate 15 mL falcon tubes.  

1.11. Centrifuge them at 300 rcf for 5 min.  

1.12. After centrifugation, discard medium. 

a. Pro tip: Take note of where the pellet is in the tube when removing from the centrifuge, 
you may mark it with a sharpie. 

b. Try not to disturb the cell pellet while removing the supernatant!  

c. When removing medium from pelleted cells, do not let aspirator pipette go past the bend 
of the cone of the falcon tube. Doing so may result in a loss of cells. 

1.13. Resuspend the first tube with 4 mL 10% CBS/medium and the second tube with 4 mL of 
0.5% CBS/ medium. Do not forget to label your tubes. Make sure your solution is mixed well 
with cells suspended throughout. 

1.14. Pipet 10 µL of the cell solution from each sample into the hemocytometer notch for 
counting the cells. You can use the A side for your 10% sample and the B side for your 0.5% 
sample. We do this to confirm the exact concentration of each sample so we can control 
seeding density for each condition.  

 

The density of cells in your final solution will vary from experiment to experiment and depends 

on the purpose of the experiment. For the purposes of this lab, we will be doing a Live/Dead 

assay. Today you will be plating your cells to be used in those experiments later next week. 

Let’s plan on plating ~2,000 cells per well of a 48-well plate to get something like Figure 4-2. 
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Figure 4-2 Example 48-well plate experimental layout 

1.15. For this experiment, you will need to end up with 2.1 mL (300 µL is extra) of each cell 
suspension at 4,000 cells per mL to plate onto your well plate. (Total number of cells you 
need is 8,400 cells in 2.1 mL). 

1.16. Label two new 15 mL falcon tubes (10% and 0.5%) for seeding the cells. 

1.17. Calculate the volume you need to take from your cell solutions (the solutions prepared at 
step 1.13 above) to get 8,400 cells. Review notes from example calculation at start of class. 

1.18. You will dilute the calculated volume from step 1.13 in a new 15 ml tube with the 
appropriate medium to bring it up to 2.1 ml. 

Show your work for these calculations here, include the calculation for cell counting and for 

calculating the cell suspension calculations: 

Cell Counting Calculations Cell Suspension Calculations 

 

 

 

 

 

 

1.19. Pipette 300 µL from your new cell solutions into each well of a new sterile 48 well plate 
according to your experiment setup (similar to Figure 4-2). You may have some extra cell 
solution leftover, so you can pipet extra wells as back-up. 

Note: make sure that your cell suspension stays well mixed, if you work very slowly, cells will 

settle to the bottom, so they may need to be periodically remixed by pipetting up and down 

again.  
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1.20. Close the well plate lid and label including: 

a. Group name 

b. Date 

c. Cell type 

d. Label wells according to experimental setup 

1.21. Check the cells in all wells with microscope to make sure you seeded them correctly. Save 
a selection of images to the folder on the laptop desktop or a USB. When naming files, 
include details of your team, well location, media concentration and magnification e.g. 
Team1_A1_10pc_4x.tif 

Please keep track of the image filenames below: 

10% Media filenames 0.5% Media filenames Calibration filenames 
.tif  .tif  .tif  
.tif .tif .tif 
.tif .tif .tif 

 

1.22. Insert a sample image that you collected from one well of your choice here: 

Insert Image here >> 

 

Insert Caption here >> .tif  

 

1.23. Place the well plate in the incubator until the next lab day. 

1.24. Ask your instructor about proper clean up and disposal protocols for all your equipment 
and materials 

1.25. Clean up and return any extra reagents to their appropriate storage location. Wipe down 
the BSC with 70% ethanol. 

1.26. You may keep leftover PBS, cell medium, and trypsin. Label it with initials and store in 
the fridge in the rack for your section. 
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Module 4 Post Lab Questions 
Please answer each of the following questions and upload to your assignment dropbox on Canvas. 

Question 1a 

From the images of cells collected from the initial flask (Step 1.2), provide a quantitative 

estimate of the confluence using ImageJ.  

 

Question 1b 

Explain the step-by-step details of how you calculated this confluence 

 

Question 1c 

Explain one limitation of the method you chose to use to calculate confluence. What alternative 

method could you use to overcome that limitation 
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Module 4 Post Lab Activity 

Post-Lab Checklist: 
 Document and submit completed procedure and post lab questions (Upload completed 

procedure page 4:1-4:7) 

 Complete Introduction Writing Assignment (Individual Assignment – details below) 

Introduction Writing Assignment: 
This week you will work individually to prepare an introduction for the experiment you started 

this week in Module 4.  

Scientific paper introductions typically have 3-4 main sections; (1) General Background, (2) 
Specific Information (3) The gap in previous research, the novelty or importance of the current 
experiment (4) A clear statement of your research questions or hypothesis. 
 
Please write all parts for this week’s lab. 

Is there a special format for my report? 

Yes, there is a lab report template which is required. Your submission will be returned and 

receive late penalty deductions if you fail to use the template. You can access the template for 

your introduction submission here or on your canvas page. 

When citating relevant sources in your lab reports, you will need to use IEEE citation style. IEEE 

in-text citations consist of numbers provided in square brackets, which correspond to the 

appropriate sources in the reference list at the end of the paper. Please review the IEEE 

Reference Guide on their website. 

How do I get an A grade? 

To get an A grade your paper will need to meet most of the “Excellent” criteria in your rubric. 

There is an A standard abstract available for you to review on Canvas. 

Please review your rubric provided below as you prepare your lab report introduction. 

Can I get feedback on my paper before submission? 

Yes! Please come to office hours, your instructional team would be delighted to answer specific 

questions and once you have completed your paper and paper self-assessment. 

  

https://sooners-my.sharepoint.com/:w:/g/personal/sabreen_ou_edu/EdLOpI4q3q5LkYpho1Pe22oBYFpq_GpvKUru2JUUVryhUA
http://journals.ieeeauthorcenter.ieee.org/wp-content/uploads/sites/7/IEEE_Reference_Guide.pdf
http://journals.ieeeauthorcenter.ieee.org/wp-content/uploads/sites/7/IEEE_Reference_Guide.pdf
https://journals.ieeeauthorcenter.ieee.org/your-role-in-article-production/ieee-editorial-style-manual/?_ga=2.171814244.512615960.1671663637-336400103.1671663637
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Introduction Rubric: 

RUBRIC Missing Poor Developing Average Adequate Excellent 

[1] General 
Background 

Not provided 
Briefly 

Mentioned 

Vague, 
background not 

relevant or 
inaccurate 

statements on 
the topic 

Gives a general 
summary of the 
purpose of the 

experiment. Doesn’t 
link background 
information to 

experiment. May 

provide one reference. 

Concise introduction, 
appropriate length. 

Clearly links background 
information to 

experiment. Provides 
one reference. 

Concise with relevant 

information pertinent to 
planned experiment. Real world 

uses stated. Provides 2-3 
references of relevant studies. 

[2] Specific 
Information  

Not provided 
Briefly 

Mentioned 

May not define 
all terms from 
hypothesis or 

may not be put 
into context 

Correctly stated in 
context, terms from 
hypothesis may be 

incorrectly defined; 
some variables not 

explained fully 

Clear statement 
describing variables, 

assumptions, and 
relationships of the 

independent/ dependent 

variables of your 
hypothesis, but not 
explained; may be 

missing typical values 
from literature 

Description of dependent and 
independent variables for 

hypothesis, assumptions and 
relationships clearly stated and 

explained; connections made to 
experiments that were tested, 
providing typical values from 

literature 

[3] The 
novelty or 
importance 

of the 
experiment 

Not provided 

Problem not 
stated clearly. 
Justification is 

entirely 
personal and 

largely 
incoherent. 

Irrelevant 
problem is 

stated. 
Justification is 

offered but 
largely personal 
and rambling. 

Problem stated 
broadly. Justification is 

offered but is not 
sufficiently grounded in 

theory or literature. 

Problem stated with 

clarity and specificity. 
Comprehensive 
background is 
articulated. 

Justification is clear 
and cognizant of 

previous research in the 

field. 

Problem stated with high degree 

of clarity and specificity. 
Comprehensive background is 

articulated with brevity. 
Justification is sharp, logical, 
and extremely well informed. 
Draws specific connection to 

what is already known and the 

importance of the study. 

[4] 
Research 
Questions 

or 
Hypothesis 

Not provided 
Briefly 

Mentioned or 
not logical 

Too little/too 
much or 

unnecessary 
info, does not 
flow well into 

the rest of the 
report; not 

logical or not 
measurable 
hypothesis 

States specific goals of 
experiment, may not 

connect back to 
background info 
provided in the 

introduction or explain 
why the experiments 

are performed 

Clearly stated, with 

connections drawn to 
background info, with 

summary of what 
experiments will be 

done and why; 
measurable hypothesis 
related to experimental 

design. 

Clearly stated with relationship 
to background info, clear 

hypothesis stated, summary of 
what experiments will be done 
and why, flows well with intro 

and prepares reader well for the 
rest of the paper; hypothesis is 
measurable, worthwhile, and 

directly tested by experimental 
design 

Grammar, 
Spelling and 
Formatting 

Clearly not 
proofread, 

inappropriate 

report length 

Several errors, text in figures 
too small 

A few errors, major 
sections labeled with 
headings, appropriate 

report length 

Less than 2 errors, 
headings and sub- 

headings used 

Correct grammar and spelling, 
legible text, headings, and sub-

headings used 

References  
No references 

cited 

No relevant references cited. 

references not cited in a 
consistent format; some 
references might be from 

Wikipedia 

At least one relevant 

reference cited. 
Several missing 

citations supporting 
claims. 

At least two relevant 
references cited. 

Two or more relevant references 
cited appropriately. All 

statements requiring citation are 
cited using IEEE style. 
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Module 5 Live/Dead Assay 

Pre Lab-Review 

Pre-Lab Checklist: 
 Read: Sanfilippo et al., 2011 “Viability assessment of fresh and frozen/thawed isolated 

human follicles: reliability of two methods (Trypan blue and Calcein AM/ethidium 
homodimer-1).”Sanfilippo, S, Canis, M, Ouchchane, L, Botchorishvili, R, Artonne, C, Janny, L, & Brugnon, 

F. “Viability assessment of fresh and frozen/thawed isolated human follicles: reliability of two methods (Trypan 
blue and Calcein AM/ethidium homodimer-1).” J Assist Reprod Genet., Vol. 28, no. 12, pp. 1151-6, 2011, 
https://doi.org/10.1007/s10815-011-9649-y  

 Submit Pre-Lab 4 (Complete Quiz on Canvas) 

Pre-Lab 5: Live/Dead Assay 
This pre-lab will be available on Canvas as a quiz with unlimited attempts and no time limit. 

Please use the space below to review and work on your questions before opening the quiz. 

1. Quantities of Reagents: 

Total Solution Volume: 

For each well that you plan to stain (i.e., the experimental wells and both positive control wells, 

refer to your notes in your lab notebook from Module 4), in your 48 well plate, you will need to 

make at least 150 µL of Live/Dead Solution. What is the minimum amount of total solution 

(Vtotal) you should make (include 10% overage)? 

What is the minimum amount of total solution (Vtotal)? [______] μL 

Show your work here: 

 

 

 

 

Reagent Volumes: 

Assume you will prepare 2 mL of the Live/Dead solution with the following dye stocks: 4.0 mM 

calcein AM and 2.0 mM Ethidium homodimer-III (EthD-III).   

In order to prepare Vtotal= 2 mL, how much (µL) of the stock calcein AM will you need for a final 

2.0 µM concentration of calcein AM? 

What volume of stock calcein AM do you need? [______] μL 

https://doi.org/10.1007/s10815-011-9649-y
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In order to prepare Vtotal= 2 mL, how much (µL) of the stock EthD-III dye solution will you need 

for a 4.0 µM concentration of EthD-III? 

What volume of stock EthD-III dye solution do you need? [______] μL 

In order to prepare Vtotal= 2 mL, how much PBS will you need to add to your dye solution to have 

a final solution total of 2 mL?  

What volume of PBS do you need? [______] μL 

Is it practical to measure this volume in the lab? What (if any) adjustments would you make? 

 

 
Show your work for all reagent calculations here: 

 

 

 

 

 

 

2. Theoretical Understanding: 

Read Sanfilippo et al., 2011 as noted in pre lab checklist and answer the following questions: 

Question 2a 

What is the purpose of the PBSTT in the procedure? 

 
 

Question 2b 

Describe the differences between how calcein and Ethidium homodimer III enter cells.   

 
 

Question 2c 

Describe how calcein AM (a non-fluorescent substrate) is able to provide a fluorescent signal in 

living cells. 

 
 

Question 2d 

Describe how EthD-III provides a fluorescent signal in dead cells. 
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Module 5 Lab Procedure 

Introduction: 
The Live/Dead assay provides green/red fluorescent staining of viable and dead cells, 

respectively, using probes for intracellular esterase activity in viable cells, and compromised 

plasma membrane integrity in dead cells. 

Calcein AM is a membrane-permeable, non-fluorescent esterase substrate, which enters the 

cytoplasm and is cleaved by esterases in live cells to yield the green fluorescent dye calcein. 

Fluorescent calcein is negatively charged and cell membrane-impermeable, and consequently is 

retained in the cytoplasm of viable cells with intact plasma membranes. Dead cells either do not 

stain with calcein due to lack of esterase activity or fail to retain calcein in the cytoplasm due 

to compromised plasma membrane integrity. 

Ethidium homodimer III (EthD-III) is a plasma membrane-impermeable DNA dye that is excluded 

by viable cells. EthD-III is virtually non-fluorescent until it binds DNA, upon which it undergoes a 

25-fold enhancement of fluorescence. EthD-III penetrates dead cells with compromised plasma 

membranes and stains the nucleus with bright red fluorescence.  

Learning Objectives 
1. Operate a fluorescence microscope to obtain images of cells for quantitative analysis 

2. Utilize positive and negative controls to determine the validity of your experiment. 

3. Quantify cell viability using a live-dead assay 

Materials 
Equipment Software Materials Misc. 
Phase Contrast Microscope AmScope 48-well plate with NIH 3T3 fibroblast cells Absorbent pad 

Fluorescence Microscope ImageJ Phosphate buffered saline (PBS) (non-sterile is ok) Foil 

  4 mM Calcein AM dye stock (green) Kimwipes 

  2 mM Ethidium homodimer-III  dye stock (red) 2 ml centrifuge tubes 

  Permeabilization buffer (PBSTT)  

Important Terms 
Vortex  

Cell Count  

Cell Viability  

Live Dead Ratio  

PBS-TT  

Positive Control  

Negative Control  

Labelled Cell  
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Safety: 
• You need to protect your skin and eyes from several chemicals today. Wear goggles, 

gloves, closed toe shoes and a lab coat. 

• Dispose of anything disposable exposed to the cells/protein in the biohazard box. 

• Clean any glassware exposed to the cells/protein with bleach before cleaning detergent 

• Use 70% ethanol to disinfect all surfaces after your experiments 

Notes: 
• Reagents are light sensitive. When storing or preparing avoid exposure to light. 

• Keep fully prepared wells in the dark until you are ready to image. 

Hypothesis 
Today we will finish a two week experiment where we will measure and compare viability, for 

cells seeded in 10% MEM and 0.5% MEM. 

What is your Hypothesis for this experiment. 

Independent Variable(s):  

Dependent Variable(s):  

Control Variable(s):  

Positive Control Condition(s):  

Negative Control Condition:  

Hypothesis:  

  



  BME 3181: BME Core Lab II 
 
 

Module 5 Page 5:3 

Procedure: 
1.1. Warm PBS in waterbath at 37°C. Non-sterile PBS is preferred since the cells will be 

terminated at the end of this assay. 
1.2. Allow the dye stocks to warm to room temperature but keep protected from light. 

a. After the stocks thaw, they need to be mixed. Make sure this has happened before 
you prepare your solutions. 

1.3. Remove the medium from only two wells and 
add 200 uL of cell permeabilization buffer 
(PBSTT) to these wells. 

a. This will serve as a positive control for 
dead staining. This will be Positive 
Control 1 (See Figure 4-2) 

b. Leave on for at least 1 minute while 
your lab mate prepares the live/dead 
solution. 

1.4. Prepare Live/Dead assay reagents according to 
your example pre-lab calculations 

a. The staining solution should be 
prepared to yield a 2 µM calcein AM/4 
µM EthD-III concentration in PBS. 

b. Vortex to ensure thorough mixing. 
1.5. Carefully remove old media and 

permeabilization buffer (PBSTT) from all 
wells of the well plate using a micropipette OR a glass pipette and vacuum. This does not 
have to be done inside of the BSC. 

1.6. Gently pipet ~0.3 mL of pre-warmed PBS into each well to wash off any residual liquid. 
Lightly tilt the dish to wash. 

1.7. Remove PBS with micropipette OR a glass pipette and vacuum. 
a. Do not let your cells dry out! 

1.8. Pipette reagents into wells as follows: 

a. Add 150 µL of the combined Live/Dead assay reagents to each experimental well  

b. Add 150 µL of the combined Live/Dead assay reagents to the Positive Control 1 

well. 

c. Add 150 µL of the instructor prepared EthD-III assay only reagents to the Positive 

Control 2 well. 

1.9. Incubate the cells for ~15 minutes at 37°C. 

1.10. Remove the Live/Dead solution by aspiration.  

1.11. Add ~0.3 mL of PBS to each well to prevent them from drying out while imaging 

  

Figure 4-2 Example 48-well plate experimental 
layout 
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1.12. View the labeled cells under the fluorescence microscope  

1.13. Capture at least three images per experimental well. Save images to the folder on the 

laptop desktop or a USB. When naming files, include details of your team, well location, 

media concentration and magnification e.g. Team1_A1_10pc_4x.tif 

Please keep track of the image filenames below: 

10% Media filenames 0.5% Media filenames Calibration filenames 
.tif  .tif  .tif  
.tif .tif .tif 
.tif .tif .tif 
.tif .tif .tif 

.tif .tif .tif 

.tif .tif .tif 

.tif .tif .tif 

.tif .tif .tif 

.tif .tif .tif 

 

1.14. Count the number of cells that appear red vs green and report your findings in 

Table 5-1 

Table 5-1. Live (L) and Dead (D) cell count data for the 10% and 0.5% Media conditions are reported for 
the three experimental wells, and averaged. 

 
10% Media 0.5% Media 

Negative 
Control 

Positive 
Control 1 

Positive 
Control 1 

Well 
1 

Well 
2 

Well 
3 

Well 
1 

Well 
2 

Well 
3 

10 % 0.5 % 10 % 0.5 % 10 % 0.5 % 

L D L D L D L D L D L D L D L D L D L D L D L D 

Image 1                         

Image 2                         

Image 3                         

Average                         

 

How to manually count the live and dead cells in Image 

J or Fiji :  
a. Open the image you want to count 

b. Select Plugins ➔ Analyze ➔ Cell Counter (or PlugIns➔ Cell 

counter) 

c. Click Initialize 

d. Click one of the type under counters sections like Type 1 

e. Click directly on a cell you wish to count, and repeat until all 

cells of that type are counted 

f. Click the next counters sections like Type 2 

g. Click directly on a cell you wish to count, and repeat until all 

cells of that type are counted 

 

 

 

 

How to automatically count the live and dead cells in 

Image J or Fiji :  
a. Open the image you want to count 

b. Split the image into its color channels (Red | Green | Blue).  

i. Select Image ➔ Color ➔ Split Channels 

ii. Discard the blue channel 

iii. Channels will be analyzed separately for live (green) and 

dead (red) cells. 

c. Convert both the red and green channels to 8-bit if required. 

i. Select Image ➔ Type ➔ 8-bit 

d. Work separately on each channel to find the image maxima. 

i. Select Process ➔ Find Maxima 

ii. Select the “Point Selection” output type 

iii. Check the box for “Preview point selection” 

iv. Adjust the “Prominence” values by increments of 5-10 

until the background staining is excluded 

v. The number of points will be the number of cells positive 

for the stain of interest. 
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1.15. Convert the average live and dead cell counts from Table 5-1 into viability data 

using Equation 5-1 and report in Table 5-2. 

Equation 5-1 Cell Viability Calculation 

𝐿𝑖𝑣𝑒 𝐶𝑒𝑙𝑙 𝐶𝑜𝑢𝑛𝑡

(𝐿𝑖𝑣𝑒 𝐶𝑒𝑙𝑙 𝐶𝑜𝑢𝑛𝑡 + 𝐷𝑒𝑎𝑑 𝐶𝑒𝑙𝑙 𝐶𝑜𝑢𝑛𝑡
× 100 

 

Table 5-2. Cell Viability data for each experimental well of the 10% and 0.5% Media conditions are 
reported along with their average and standard deviation. Cell Viability is also presented for each 
control well. 

 
10% Media 0.5% Media 

Negative 
Control 

Positive 
Control 1 

Positive 
Control 2 

Well 1 Well 2 Well 3 Well 1 Well 2 Well 3 10% 0.5% 10% 0.5% 10% 0.5% 

Cell Viability             

Average         

St. Deviation         

Module 5 Post Lab Questions 
Question 1 [Results] 

Please prepare a graphical figure to show your results. This Figure should allow the reader to 

determine if the experimental conditions significantly affected the ratio of living to dead cells? 

You will need to use some statistics to understand the difference between two conditions and 

show the results of this statistical analysis in your figure. 

Insert Image here >> 

 

Insert Caption here >>   
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Question 2 [Discussion i] 

When writing a lab report discussion, you need to identify if your hypothesis was supported. Did 

your results match your predictions that you made in the pre-lab? Why or why not? 

 

Question 3 [Discussion ii] 

When reviewing the experimental results, you need to ensure the validity of your experiment. 

Please discuss the validity of your experiment by reviewing your positive and negative control 

results. 

 

Question 3 [Discussion iii] 

When writing a lab report discussion, you need to integrate limitations. Please describe at least 

2 limitations to this live-dead assay. Do not describe what can go wrong with the assay, but 

rather the limitation of the method to assess viability. Can you think of an alternative method 

that would address these limitations? 
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Module 5 Post Lab Activity 

Post-Lab Checklist: 
 Document and submit completed procedure and post lab questions (Upload completed 

procedure page 5:1-5:6) 

 Complete Methods Writing Assignment (Individual Assignment – details below) 

 

Methods Writing Assignment: 
This week you will work individually to prepare a methods section for the two week experiment 

you started last week in Module 4 and completed this week in Module 5.  

Scientific papers always include a methods section. Methods sections typically include several 

sections ; (1) Experimental Design, (2) Experimental set-up (3) Measurements and analysis. 

 

Please write all parts for this week’s lab. 

Is there a special format for our lab reports? 

Yes, there is a lab report template which is required. Your submission will be returned and 

receive late penalty deductions if you fail to use the template. You can access the template for 

your methods section submission here or on your canvas page. 

When citating relevant sources in your lab reports, you will need to use IEEE citation style. IEEE 

in-text citations consist of numbers provided in square brackets, which correspond to the 

appropriate sources in the reference list at the end of the paper. Please review the IEEE 

Reference Guide on their website. 

How do I get an A grade? 

To get an A grade your paper will need to meet most of the “Excellent” criteria in your rubric. 

There is an A standard abstract available for you to review on Canvas. 

Please review your rubric provided below as you prepare your lab report methods section. 

Can I get feedback on my paper before submission? 

Yes! Please come to office hours, your instructional team would be delighted to answer specific 

questions and once you have completed your paper and paper self-assessment. 

  

https://sooners-my.sharepoint.com/:w:/g/personal/sabreen_ou_edu/EfY4rWVz4wJPhE9rGDPlJ78Bb-Ao2X1tnAXy1ssce5HciA?e=aNGr35
http://journals.ieeeauthorcenter.ieee.org/wp-content/uploads/sites/7/IEEE_Reference_Guide.pdf
http://journals.ieeeauthorcenter.ieee.org/wp-content/uploads/sites/7/IEEE_Reference_Guide.pdf
https://journals.ieeeauthorcenter.ieee.org/your-role-in-article-production/ieee-editorial-style-manual/?_ga=2.171814244.512615960.1671663637-336400103.1671663637
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Methods Section Rubric: 

Should be written in third person past tense. 

RUBRIC Missing Poor Developing Average Adequate Excellent 

[1] 
Experimental 

design 

Not provided 
Briefly 

mentioned, 
unclear. 

States the 
experimental 
parameters 

used, but little 
or no 

explanation of 
why they were 
chosen. Most 
participant or 

specimen 
demographics 

are missing. 

Appropriate design but 
may not have 

attempted to collect 
appropriate data for 
full assessment of 
hypothesis. Most 

participant or 
specimen 

demographics are 
detailed clearly. 

Describes how/why 
experimental 

parameters were 
selected, may be 

missing appropriate 
controls. All 

participant or 
specimen 

demographics are 
detailed clearly. 

Provides clear and concise 
reasoning for how/why 

experimental parameters were 
selected; Appropriate controls 

included. All participant or 
specimen demographics are 

detailed clearly and concisely 

[2] 
Experimental 

Setup  

Not provided 
Briefly 

mentioned, no 
details 

Too vague, may 
not say how 
many trials 
performed. 
Most data 

collection tools 

are missing 

Basic summary of how 
experiments were 

performed, may omit 

some specific details, 
includes number of 

trials. Most data 
collection tools are 

identified. 

Summarizes all details 
for creating 

experimental 
conditions, including 

description of all 
independent variables 
used and number of 

trials. All data 
collection tools are 

identified. 

All key details for creating 
experimental conditions clearly 
and concisely included such that 

a skilled researcher could 
replicate the experiment, 

includes a diagram or table 
summarizing experimental 

conditions if necessary. All data 
collection tools are identified. 

Manufacturer details and 
software versions are specified 

correctly. 

[3] 
Measurement 

& Analysis 

Not provided 

May be 
incorrect or 
only briefly 

mentioned 

Data analysis 
procedures are 

described. 
Most required 
elements are 

missing. 
Incorrect 

explanation, 

missing info, 
experiment 

never repeated 

Data analysis 
procedures are 

described clearly. Most 
required elements are 
included. Simply states 

statistics tests used; 
experiments repeated 

at least twice 

Data analysis 
procedures are 

described clearly. Most 
required elements are 

included. States 

how/why statistics were 
chosen; experiments 

repeated appropriately. 

Data analysis procedures are 
described clearly and 

succinctly. All required 

elements are included [key 
steps of data processing, 

calculation of variables]. States 
how/why statistics were chosen; 

experiments repeated 
appropriately. 

Grammar, 
Spelling and 
Formatting 

Clearly not 
proofread, 

inappropriate 
report length 

Several errors, text in figures 
too small 

A few errors, major 
sections labeled with 
headings, appropriate 

report length 

Less than 2 errors, 

headings and sub- 
headings used 

Correct grammar and spelling, 

legible text, headings, and sub-
headings used 

References  
No references 

cited 

No relevant references cited. 
references not cited in a 

consistent format; some 
references might be from 

Wikipedia 

At least one relevant 
reference cited. 

Several missing 
citations supporting 

claims. 

At least two relevant 
references cited. 

Two or more relevant references 
cited appropriately. All 

statements requiring citation are 
cited using IEEE style. 
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Module 6 Primary Cell Isolation  

Pre Lab-Review 

Pre-Lab Checklist: 
 Review Cell Counting Procedure from Module 4 

 Review Live Dead Procedure from Module 5 

 Submit Pre-Lab 6 (Complete Quiz on Canvas) 

Pre-Lab 6: Primary Cell Isolation 
This pre-lab will be available on Canvas as a quiz with unlimited attempts and no time limit. 

Please use the space below to review and work on your questions before opening the quiz. 

Read through the cell isolation procedure carefully. You will have to read the procedure to 

answer the questions below correctly.  

To finish the lab on time, all group members should be familiar with the procedure and 

comfortable with both Live/Dead and cell counting procedures. Review your notes about 

live/dead and cell counting to refresh your memory. 

Question 1: 

If you have 0.45 g of cartilage (wet weight), what volume of collagenase solution should you 

make, if you need 6.0 mL for every gram of cartilage to be digested and include 25% overage? 

What volume of collagenase do you need? [______] mL 

Show your work here: 
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Question 2: 

You have suspended your cell pellet in 1.0 mL of medium. Using the hemocyotometer, you have 

counted 205 cells in 5 of the boxes. You plan to seed your cells into wells of a 48-well plate, 

which has wells with an area of 0.95 cm2. 

How many wells do you have enough cells for? [______] wells 

Show your work here: 

 

 

 

 

 

What volume of your cell suspension, should you add to each well of your 48-well plate? 

[______] μL 

Show your work here: 
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Module 6 Lab Procedure 

Introduction: 
This experiment involves enzymatically digesting cartilage to release chondrocytes from their 

surrounding ECM. Specifically, cartilage is minced into small pieces and digested with collagenase 

for ~1 hour. Large pieces of undigested tissue are then separated from the isolated cells using a 

strainer and a monolayer culture is established with the freshly isolated chondrocytes. While the 

cartilage is being digested, the viability of cells within a sample of intact cartilage can be observed 

using a Live/Dead assay and fluorescence microscope. 

Learning Objectives 
1. Operate a fluorescence microscope to obtain images of cells for qualitative analysis 

2. Quantify cell viability of cartilage using a live-dead assay 

3. Isolate and seed chondrocyte cells from fresh articular cartilage  

Materials 
Equipment Software Materials Misc. 
Phase Contrast Microscope AmScope Fresh articular cartilage (~0.5 g wet weight) Absorbent pad 

Fluorescence Microscope ImageJ Serum -free chondrocyte medium (+anti-anti + L-proline) Foil 

Cell strainer (40 μm mesh)  Chondrocyte medium (10% CBS +anti-anti + L-proline) Sterile 50 ml tube 

Sterile stir bar  0.60 % Collagenase solution (4 ml) 100 mm petri dish 

Sterile scalpel + blade  1x Phosphate buffered saline (PBS) (with Ca2+ and Mg2+)  

Sterile spatula + forceps  4 mM Calcein AM dye stock  

48-well plate (sterile, 
tissue culture treated) 

 2 mM Ethidium homodimer-III  dye stock  

 Phosphate buffered saline (PBS) (non-sterile)  

  70% Ethanol (EtOH)  

Important Terms 
ECM  

Chondrocytes  

Collagenase  

Monolayer culture  

Isolation  

Aliquot  

Serum-free  

Sterile  

  

Safety: 
• You need to protect your skin and eyes from several chemicals today. Wear goggles, gloves, 

closed toe shoes and a lab coat. 

• Dispose of anything disposable exposed to the cells/protein in the biohazard box. 

• Clean any glassware exposed to the cells/protein with bleach before cleaning detergent 



  BME 3171: BME Core Lab I 
 
 

Module 6 Page 6-2 

• Use 70% ethanol to disinfect all surfaces after your experiments 

Notes: 
• Reagents are light sensitive. When storing or preparing avoid exposure to light. 

• Keep fully prepared wells in the dark until you are ready to image. 

Hypothesis 
Today we will start a two-week experiment where we will prepare chondrocyte cells for 

proliferation and measure and compare the cells doubling time against, expected values in the 

literature. 

What is your Hypothesis for this experiment. 

Theoretical Assumption being tested:  

Dependent Variable(s):  

Control Variable(s):  

Positive Control Condition(s):  

Negative Control Condition:  

Hypothesis:  
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1. Steps completed in advance by your instructors: 
Prepare 0.60 % collagenase solution [Already completed by your instructor] 

1.1. In a clean 30 mL beaker, weigh out the appropriate amount of collagenase needed to 
make a 0.60% solution 

1.2. Within the BSC, dissolve the collagenase in serum-free chondrocyte media. Mix up and 
down to dissolve. 

1.3. Sterilize the collagenase solution by passing it through a 0.2 μm syringe filter. Collect 
the filtrate in a sterile 15 ml tube as demonstrated in the pre-lab video. 

1.4. Cap the tube and place it in the incubator or 37°C water bath to warm the 
collagenase solution. 

Determine wet weight of the cartilage to be digested [Already completed by your instructor] 

1.5. Measure and record the mass of an empty, sterile 50 ml centrifuge tube. 
1.6. In the BSC, pour the contents of the 15 ml tube with cartilage into to the sterile 50 ml 

tube to be digested. 
1.7. Using a sterile spatula, transfer two cartilage fragments into a 48 well plate. Close 

and place this well plate aside to be used later to assess cell viability within the tissue. 
1.8. Gently aspirate the liquid surrounding the cartilage from the 50 ml tube, leaving just 

enough to hydrate the tissue. 
1.9. Cover the 50 ml tube and re-weigh it to determine the tissue’s wet weight.  
1.10. You will only have 4 ml of available collagenase solution therefore if your wet weight 

is >0.5 g please discard some cartilage to ensure your wet weight is < 0.5 g 

Optional: if there are large chunks (> ~ 3 mm2) of tissue, mince the cartilage: 

1.11. Place cartilage in petri dish 
1.12. Aspirate off excess media surrounding the cartilage in the petri dish, leaving just 

enough to maintain tissue hydration. 
1.13. Carefully mince the cartilage into fragments, each a few cubic millimeters in volume 

(like small bacon bits ☺), using a sterile scalpel and forceps. 
1.14. IF YOU HAVE YOUR COLLAGENASE SOLUTION READY, PLEASE SKIP THIS STEP. THIS IS 

ONLY REQUIRED TO KEEP YOUR CARTILAGE HYDRATED. Rehydrate the tissue with 
approximately 4 ml of sterile serum-free medium and set the 50ml tube aside in the BSC. 

2. Cell Digestion Procedure: 
The following protocol is for a relatively high collagenase concentration and short digestion time. 
For higher cell yield, the procedure could be performed over a much longer period of time by 
decreasing the collagenase concentration and increasing the digestion time (e.g., 0.018% for 16 h) 

2.1. Have one member of your group prepare the biosafety cabinet for use by wiping it 
down with 70% ethanol and arranging necessary reagents and disposables. 

2.2. Meanwhile, have one member of your group sterilize the stir bar, forceps, scalpel 
handle, and spatula in 70% ethanol 
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a. This can be done by submerging the utensils in a centrifuge tube with 70% EtOH and 
then letting them air dry in the BSC in a sterile container, such as a sterile 100 mm 
petri dish.  

i. Push these back toward the back of the BSC, so that they don’t get 
contaminated by anyone moving things over them. 

b. This needs to be done well in advance, so the ethanol has time to evaporate. 
2.3. Prepare collagenase solution 

a. Retrieve the warm collagenase solution, place it in the BSC,  
b. Determine the volume of collagenase solution needed; you need 6.0 mL for every 

gram of cartilage to be digested (like your pre-lab calculation). 

Show your work here: 

 

 

 

 

 

2.4. Gently aspirate off any remaining liquid surrounding the cartilage. 
2.5. Place the appropriate volume of warm collagenase solution into the 50 mL tube 

onto the cartilage. 
2.6. Add a sterile stir bar to the 50 mL tube. 
2.7. Cap the 50 mL tube and start a timer. This tissue will be digested in collagenase for 

1 hour. Longer incubation times will increase cell yield. 
2.8. Your instructors have prepared the magnetic stir plate and placed it on the bottom 

shelf of the incubator. Place the 50 mL tube on the stir plate and adjust the speed to stir 
the solution gently. 

a. Be sure the door is closed tightly, and the temperature and percentage of CO2 are 
stable. 

b. Tighten the lid fully (not too tight that you break the seal).  
c. Flip the 50 mL tube upside down so that it stands up on the stir plate, make sure all 

the tissue is submerged in the collagenase solution. 

3. Tissue Viability Procedure: 
While the tissue is digesting, measure the viability of cells within the reserved cartilage pieces. It 

is not necessary to keep the fragments sterile since they will be discarded after viability has been 

assessed. 

3.1. For each tissue fragment, mix 2 μL calcein AM, 2 μL EthD-1, and 200 μL non-sterile 
PBS. 

3.2. Cover the plate to protect the samples from light and incubate for 10 min at room 
temperature. 

3.3. Remember: after incubation, the cytoplasm of the live cells will fluoresce green, and 
the nucleus of dead cells will fluoresce red. 

3.4. Check with an instructor to make sure that the fluorescent lamp has been allowed to 
warm up for about 10 min. 
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3.5. Remove the stain solution and place 200 μL non-sterile PBS in each well. 
3.6. Determine chondrocyte cell viability by estimating the percentage of cells that are 

alive within a representative region in each cartilage fragment. 
a. Is viability lower near cut surfaces? Is the whole fragment stained or would a longer 

incubation time be beneficial? 

 
 

 

b. Capture two representative microscope images of the cartilage. Save images to the 

folder on the laptop desktop or a USB. When naming files, include details of your 

team, specimen and magnification e.g. Team1_A1Cartilage_4x.tif 

Please keep track of the image filenames below: 

Cartilage viability filenames Calibration filenames 
.tif  .tif  
.tif .tif 

 

c. Insert two of the images and the cell count estimates here: 

Replace this text with image Replace this text with image 

Estimated Cell Viability: [___] % Estimated Cell Viability: [___] % 

Replace this text with caption Replace this text with caption 

 

4. Cell Isolation Procedure: 
4.1. At the end of the collagenase incubation period, transfer the 50 ml tube from the 

incubator to the BSC and pass the digested solution through the 40 μm cell strainer into a 
new sterile 50 mL centrifuge tube. The strainer will remove any large, undigested pieces of 
cartilage. 

a. Drip a few mL of sterile serum free media over the cell strainer to wash any 
additional cells through and increase yield. 

b. Dispose of the cell strainer and any leftover debris. 
4.2. Wash the chondrocytes by adding 10 mL of cold sterile PBS to the conical tube. 

a. Spin cells down using a centrifuge, at 500 RCF for 3 min. 
b. Observe the pellet and discard the supernatant. 

4.3. Resuspend the cell pellet in 10.0 mL of 10% CBS chondrocyte media. If your pellet is 
not visible or very small adjust this resuspension volume to 1 ml and adjust your 
calculations accordingly. 

4.4. Use a hemocytometer to determine the density of cells in the suspension. Show your 
work for these calculations below, include the calculations for cell counting and for the cell 
suspension: 
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Cell Counting Calculations Cell Suspension Calculations 

  

4.5. Plate the cells in 4 wells of a new 48-well plate (make sure it is for tissue culture, not 
suspension) at a density of 800 cells/cm2 (each well is approximately 1 cm2). 

a. Refer to your pre-lab calculations for help. 
4.6. Add media to reach a total volume of 0.5 mL in each well of the 48 well-plate. 
4.7. Label your well plate with your initials, date, and cell type. Also indicate on the lid 

which wells contain cells. 
4.8. Place your well plate in the incubator until next lab period. 

Module 6 Post Lab Questions 
Question 1 

Calculate the efficiency of the isolation protocol.  Assume that the cartilage contained exactly 5.0 

x 107 cells per gram wet weight (Kim et al. 1988). Use the percentage viability estimated in the 

Live/Dead assay and measured wet weight to estimate the number of viable cells originally within 

the cartilage. 

 

Question 3 

During the next lab period you will approximate how many cells you have with a DNA Assay. If 

chondrocytes have a doubling time of 20.0 hours, how many cells would you expect per well? Make 

sure to include the method you use to estimate. Are there any limitations to this method? 

 

Reference: 

Kim, Y. J., R. L. Sah, J. Y. Doong, and A. J. Grodzinsky. 1988. Fluorometric assay of DNA in 

cartilage explants using Hoechst 33258. Analytical Biochemistry.174 (1): 168 – 176 

Post-Lab Checklist: 
 Document and submit completed procedure and post lab questions (Upload completed 

procedure page 6-1-6-6) 
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Module 7 dsDNA Quantification Assay 

Pre Lab-Review 

Pre-Lab Checklist: 
 Read: Ch 13, Sections 13.11-13.13 from Fundamentals of Biomechanics “Stress & Strain” by 

Ӧzkaya et al., 2017. 
Özkaya, N., Leger, D., Goldsheyder, D., Nordin, M. "Stress & Strain." in Fundamentals of Biomechanics. Switzerland, Springer, 2017. 287-
316. https://doi-org.ezproxy.lib.ou.edu/10.1007/978-3-319-44738-4_13  

 Submit Pre-Lab 7 (Complete Quiz on Canvas) 

Pre-Lab 7: dsDNA Quantification Assay 
Cell-based tissue-engineering therapies typically require tens of millions or billions of cells per 
patient. In general, it is not feasible to isolate enough primary cells directly from tissue. To expand 
the number available, cells are cultured in vivo, in conditions that stimulate cell division. 

We will use a simplified growth model to predict the number of cells in culture: 

𝑋 = 𝑋0𝑒𝜇𝑡 or 𝑋 = 𝑋02
𝑡

𝑡𝑑
⁄

 

Where: 

X = the number of cells currently in culture 

X0 = initial cell number 

μ = growth rate 

td = doubling time 

Cell growth in culture can be monitored by plotting the density (or number) of cells versus time in 
culture. Multiple experimental methods can be used to measure the number of cells in culture at a 
particular point in time. For example, a DNA assay can provide a quantity of DNA in sample. That 
quantity of DNA can be related to the number of cells based on a predicted and established amount 
of DNA per cell. 

Using the AccuGreen dsDNA quantitation assay, you can selectively detect as little as 100 pg of 
dsDNA in the presence of ssDNA, RNA, and free nucleotides. After the cells have been lysed, the 
AccuGreen solution can be added to the sample and run on a spectrophotometer to gain insight 
into the number of cells in that given sample. This pre-lab will walk you through setting up the 
layout of your well plate. 

Read through the dsDNA Assay procedure carefully. You will have to read the procedure to answer 

the questions below correctly.  

  

https://doi-org.ezproxy.lib.ou.edu/10.1007/978-3-319-44738-4_13
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Question 1 [DNA Standards]: 

Complete the table below to prepare a series of 25.0 µL DNA standards from 10.0 ng/µL DNA 

standard stock solution. You will make each standard in 1.5 mL centrifuge tubes as follows:  

Volume of DNA 
standard used (μL) 

Volume TE Buffer 
(μL) 

Standard concentration 
obtained (ng/µL) 

ng DNA per well (using 
10 μL samples) 

25.00 0.00 10.00 100.00 

  7.00  

  5.00  

  2.00  

  0.50  

  0.00  

 

Show a sample calculation here: 

 

 

 

 

 

 

Question 2 [Well plate layout]: 

Plan the well-plate layout.  

i. Each sample/standard should be assayed in duplicate, meaning each of the 6 standards 
and each of your samples from the last lab should be done in two separate wells each.  

ii. X indicates wells not to be used, the outside wells are typically ignored on the model 
plate reader used in class, because they may exhibit inconsistent results. 

iii. Identify where you will pipet your “unknowns”. These should also be measured in at least 
duplicate. 

 1 2 3 4 5 6 7 8 9 10 11 12 

A X X X X X X X X X X X X 

B X           X 

C X           X 

D X           X 

E X           X 

F X           X 

G X           X 

H X X X X X X X X X X X X 
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Question 3 [Reagent Calculations]: 

Answer the following questions to calculate the amount of AccuGreen reagents needed.  

 

You will need 150 µL of total working solution per well of your culture plate. You must do every 

sample and standard in duplicate, how much working solution do you need?  Add 10.% overage. 

Vtotal(μL) = [(# of samples + # of standards) * 2 ) * 150 μL]*1.1 

What volume of working solution do you need? Vtotal(μL) =  [______] μL 

Show your work here: 

 

 

 

 

 

 

To make your final solution you must mix 200x AccuGreen dye and AccuGreen Buffer solutions at a 

ratio of 1:200. Given the total volume of working solution (Vtotal), calculated in part (a), how much 

AccuGreen dye and how much AccuGreen Buffer Solution do you need (µL)? 

What volume of AccuGreen dye do you need? [______] μL 

What volume of AccuGreen Buffer Solution do you need? [______] μL 

Show your work here: 

 

 

 

 

 

 

Question 4 [Cell Count & DNA Estimations]: 

During the last lab period you approximated your initial cell density. If chondrocytes have a 

doubling time of 20 hours 

How many cells would you expect per well of the culture plate? [______] cells 

Show your work here: 
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Given the estimated 8 μg of DNA per 106 chondrocytes, how much DNA would you expect to 

measure from each well? 

How much DNA would you expect from each well of the culture plate? [______] μg of DNA 

Show your work here: 

 

 

 

 

 

 

Hypothesis 

This week we will finish a two-week experiment where we will quantify cell proliferation, for 

chondrocyte cells harvested from fresh articular cartilage. 

 

What is your Hypothesis for this experiment. 

Theoretical Assumption(s):  

Dependent Variable(s):  

Control Variable(s):  

Positive Control Condition(s):  

Negative Control Condition:  

Hypothesis:  
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Module 7 Lab Procedure 

Introduction: 
AccuGreen assays are based on binding of fluorescent DNA dyes that selectively detect double-

stranded DNA over RNA or single-stranded DNA. Using the AccuGreen dsDNA quantitation assay, you 

can selectively detect as little as 100 pg of dsDNA in the presence of ssDNA, RNA, and free 

nucleotides. After the cells have been lysed, the AccuGreen solution can be added to the sample 

and run on a plate reader to gain insight into the number of cells in that given sample.   

Learning Objectives 
1. Quantify dsDNA using an AccuGreen assay 

Materials 
Equipment Software Materials Misc. 
Phase Contrast Microscope AmScope Prepared 48-well plate with chondrocyte cells Absorbent pad 

Fluorescence Microscope ImageJ 200x AccuGreen dye Foil 

Opaque 96 V bottom well 
plate 

Gen5 AccuGreen Buffer Solution Sterile 50 ml tube 

  10 ng/mL DNA standard 100 mm petri dish 

  PBST-T (0.05% Tween + 0.5% Triton-x in PBS) 1.5 ml centrifuge tubes 

   Serological pipettes + micropipettes 

    

    

    

Important Terms 
  

  

  

  

  

  

  

  

  

  

Safety: 
• You need to protect your skin and eyes from several chemicals today. Wear goggles, gloves, 

closed toe shoes and a lab coat. 

• Dispose of anything disposable exposed to the cells/protein in the biohazard box. 

• Clean any glassware exposed to the cells/protein with bleach before cleaning detergent 

• Use 70% ethanol to disinfect all surfaces after your experiments 



  BME 3171: BME Core Lab I 
 
 

Module 7 Page 7-2 

Notes: 
• AccuGreen is light sensitive. When storing or preparing avoid exposure to light. 

• Keep fully prepared well in the dark until you are ready to put the plate in the microplate 
reader. 

• You are working with small volumes, make sure to practice good pipetting skills for the best 
accuracy. 

Hypothesis 
This week we will finish a two-week experiment where we will quantify cell proliferation, for 

chondrocyte cells harvested from fresh articular cartilage. 

What is your Hypothesis for this experiment. 

Theoretical Assumption(s):  

Dependent Variable(s):  

Control Variable(s):  

Positive Control Condition(s):  

Negative Control Condition:  

Hypothesis:  
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Module 7 Procedure 
1. Lyse cells 

1.1. Remove the well plate containing your isolated cells from the incubator 
1.2. Look at them under the microscope and note the relative number of cells and confluence. 

 Well 1 Well 2 Well 3 Well 4 

Well Location (e.g. A3)     

Estimated Confluence     

 
1.3. Aspirate the media from each well. 
1.4. Add 100 μL of PBSTT permeabilization solution to each well of the plate that contains cells. 

a. Let the plate incubate at room temp while you finish preparing DNA reagents. 
b. Ensure that the monolayer of cells is covered by the PBSTT solution. 
c. Use the pipet tip to scrape the bottom of the well to help detach and lyse cells 

2. Prepare DNA Assay Reagents 

2.1. Ensure that kit components are warmed to room temperature and are well mixed.  
a. If you see any precipitation in the solutions, vortex until dissolved 
b. Briefly centrifuge small vials before opening to minimize reagent loss on the cap 

2.2. Have one member of your group prepare DNA standards determined from pre-lab and noted 
below: 

Confirm your DNA Standard volumes here: 

Volume of DNA 
standard used (μL) 

Volume TE Buffer 
(μL) 

Standard concentration 
obtained (ng/µL) 

ng DNA per well (using 
10 μL samples) 

25.00 0.00 10.00 100.00 

  7.00  

  5.00  

  2.00  

  0.50  

  0.00  

 
2.3. Meanwhile, have another member of your group prepare the working solution for the DNA 

assay.  
a. Prepare 150 µL plus 10% overage of working solution, per well of the 96 well plate you 

will use. 
i. To determine the number of wells in the 96-well plate, you will need to know the 

number of samples and the number of standards you will measure. Remember the 
number of samples (i.e. number of wells plated with chondrocytes) from the 
previous lab. Review the pre-lab to determine the number of standards. Then 
account for the fact that you will do all measurements in duplicate. Finally makes 
sure to add 10% overage. 



  BME 3171: BME Core Lab I 
 
 

Module 7 Page 7-4 

b. You will need to mix the 200X AccuGreen Dye solution with the AccuGreen Buffer at a 
ratio of 1:200 (e.g., 1 µL of 200X AccuGreen Dye + 199 µL AccuGreen Buffer = 200 μL 
working solution). 

c. Mix the working solution well.  

Confirm your Working Solution volumes here: 

Total volume (µL) 200X AccuGreen Dye (µL) AccuGreen Buffer (µL) 

   

 

Prepare 96-well plate for DNA Assay 
Confirm your 96 well plate layout here: 

 1 2 3 4 5 6 7 8 9 10 11 12 

A X X X X X X X X X X X X 

B X           X 

C X           X 

D X           X 

E X           X 

F X           X 

G X           X 

H X X X X X X X X X X X X 

 
2.4. Add 10 µL of each dsDNA standard and unknown (cell sample) to its own separate well of an 

opaque 96-well plate according to the well plate layout above.  

a. Don’t forget, you will be testing the samples in duplicate. So, you will need to prepare 
two separate wells for each DNA standard and each unknown sample 

2.5. Pipet 150 µL of working solution into each well of the 96-well plate that contains samples or 
standards. 

2.6. Mix wells by pipetting up and down (be careful to replace micropipette tips in order to 
minimize cross-contamination). 

2.7. Incubate the microplate at room temperature for about 2 minutes before reading on the 
spectrophotometer.  

2.8. Measure fluorescence using a spectrophotometer using the green fluorescent cube. 
a. Make sure the Greiner 96 V Bottom dish is selected. Check the “Use Lid” box, and 
make the “Read Height” 11.00 mm. 
b. Note the fluorescent wavelengths used on the spectrophotometer. 

 
 

 
2.9. Remember to save your results to the desktop or to a USB drive. 
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3. Data Analysis 

3.1. Generate a standard curve to determine the 
unknown DNA concentration. 

a. Plot the fluorescence values for the DNA 
standards on the y-axis and the ng/μL of DNA 
on the x-axis.  

b. Fit a trend line through these points to 
generate a standard curve trend line similar to 
Figure 1. 

3.2. Use the equation for the standard curve trend line to 
calculate the amount of unknown DNA in each well (y = 
fluorescence and x = ng/μL DNA per well).  

 
Note: the standard curve shown in Figure 1 is for reference 
only. You must generate your own standard curve using the plate reader results to calculate the 
amount of DNA in your unknown samples. 

Important: be careful and consistent about units on the x-axis: ng vs ng/μL vs ng/well. 

 
3.3. Using statistical analysis determine whether your cell numbers are significantly different 

from your predicted cell number. 

Module 7 Post Lab Questions 
This week you will work individually to prepare a results & discussion sections for the two week 

experiment we just completed, below are some questions to prompt your discussion writing. 

Question 1 [Discussion i] 

Explain the results of your statistical analysis used to determine whether your cell numbers are 

significantly different from your predicted cell number. Did your results match your predictions 

that you made in pre-lab? Why or why not? 

 

Question 2 [Discussion ii] 

What are the limitations of the growth model that was used to predict the number of cells? [This 

may be useful to help explain any differences between your results and your prediction] 

 

Question 3 [Discussion iii] 

Describe at least 2 limitations to this DNA assay. Do not list limitations due to human error, but 

rather the limitations of the experimental methods. Can you think of an alternative method that 

would address these limitations? 

 
  

Figure 7-1 Example DNA Standard Curve 
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Module 7 Post Lab Activity 

Post-Lab Checklist: 
 Document and submit completed procedure (Upload completed procedure page 7-1-7-5) 

 Complete Results & Discussion Writing Assignment (Individual Assignment – details below) 

Group Results & Discussion Writing Assignment: 
Is there a special format for your lab reports? 

Yes, there is a lab report template which is required. Your submission will be returned and receive 

late penalty deductions if you fail to use the template. You can access the template for your 

results and discussion submission here or on your canvas page. 

When citating relevant sources in your lab reports, you will need to use IEEE citation style. IEEE in-

text citations consist of numbers provided in square brackets, which correspond to the appropriate 

sources in the reference list at the end of the paper. Please review the IEEE Reference Guide on 

their website. 

How do I get an A grade? 

To get an A grade your paper will need to meet most of the “Excellent” criteria in your rubric. 

There is an A standard results & discussion section available for you to review on Canvas. 

Please review your rubric provided below as you prepare your lab report results & discussion. 

What do we include in the results section? 

Please follow your rubric but including the key items below is a great start: 

• REQUIRED TABLE: 
o Must Include average and standard deviation data for each dependent variable. 
o Must include p-value for comparison of sample sets. 
o Should not include raw replicate data. 

• REQUIRED SUPPORTING TEXT: 
o Each Table & Figure that is provided in your results section needs to be mentioned in 

the main body text of either your results or discussion section. 

• OPTIONAL FIGURE: 
o A figure displaying your data would be very useful for visual comparison. 

Can I get feedback on my group’s paper before submission? 

Yes! Please come to office hours, your instructional team would be delighted to answer specific 

questions and once you have completed your paper and paper self-assessment. 

  

https://sooners-my.sharepoint.com/:w:/g/personal/sabreen_ou_edu/EUwuHUdEeAJOq2DPSrQK2ecB6mgs9hIXswNjBc2fhC6Dlw?e=G3GRTu
http://journals.ieeeauthorcenter.ieee.org/wp-content/uploads/sites/7/IEEE_Reference_Guide.pdf
https://journals.ieeeauthorcenter.ieee.org/your-role-in-article-production/ieee-editorial-style-manual/?_ga=2.171814244.512615960.1671663637-336400103.1671663637
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Results & Discussion Rubric 

RUBRIC Missing Poor Developing Average Adequate Excellent 

[1a] Data 
Presentation 

tables & 
figures 

 No data 
provided 

Figures and or tables are 

not well-designed and 
have several issues and 

the choice of data 

presentation is an 
inaccurate representation 

of the data collected 
and/or data is missing. 

Figures and or tables do 
not use space effectively 

and would benefit from 
redesign. 

There are several 
instances of extra 

information in the figures 
or tables. 

Axes, symbols, legends, 
etc. are not labeled, have 

incorrect units, or are 
missing. 

Captions are lacking key 
pieces of information or 

experimental details. 

Figures and or tables have 
several issues and the 

choice of data 
presentation may not 

clearly match the 
hypothesis. 

Figures and or tables may 
not use space effectively 

and would benefit from 
redesign. 

There are some instances 
of extra information in the 

figures or tables. 
Axes, symbols, legends, 

etc. may not be correctly 
labeled, or have incorrect 

units, or may be missing. 
Captions contain some of 
the information needed to 

interpret the figure but 

are missing more than two 
minor details. 

Figures and or tables 
adequately show the data 

and are mostly well-
designed with a few minor 

issues. 
There are a few instances 

of extra information in the 
figures or tables. 

Axes, symbols, legends, 
etc. are appropriately 

labeled with correct units 
with two minor 

exceptions. 
Captions contain most of 

the information needed to 
interpret the figure but 

may be missing one or two 
minor details. 

Figures and or tables 
adequately show the data 

and are mostly well-
designed. 

Figures and or tables 
mostly use space in 

effectively. 
There may be one or two 

instances of extra 
information in the figures 

or tables. 
Axes, symbols, legends, 

etc. are appropriately 
labeled with correct units 

with one minor exception. 
Captions contain the 

appropriate details for the 
data presented. 

Figures and or tables are 
well-designed and are the 

best representation of the 
data. 

Figures and or tables use 
space in the report 

effectively 
There is no extra 

information, titles, 
coloring, gridlines, or 

other features in the 
figures. Tables are concise 

and do not include extra 
information such as raw 

trial data, or t-values. 
All axes, symbols, legends, 

etc. are appropriately 
labeled with correct units. 

Captions are clear and 
concise and contain the 

appropriate details for the 
data presented. 

[1b] Data 
Presentation 

text 

 

None of the figures, 

diagrams, and tables are 
referred to in text. 

Some of the figures, 

diagrams, and tables are 
not referred to in text. 

Most figures, diagrams, 
and tables are referred to 

in the body of the report 
text. 

All figures, diagrams, and 
tables are referred to in 

the body of the report 
text. 

All figures, diagrams, and 
tables are referred to 

succinctly in the body of 
the report text. 

[2] Data 
Validity 

No data 

provided 

Data analysis is incorrect 

and/or incomplete. 

Data analysis is mostly 

inaccurate with several 
minor errors. 

Data analysis is mostly 
accurate with two minor 

errors. 

Data analysis is mostly 

accurate with one minor 
errors. 

Data analysis is accurate 

and complete.  
Data matches the 

hypothesis presenting the 
average and standard 

deviation for each 

dependent variable across 
each level of the 

independent variable. 
Correct and precise P 

values for each 
comparison are also 

included. 

[1]  
Discusses 
results  

 No data 

provided 

Discussion of data is vague 

or not present  
. 

Not all data is discussed  

 

Discussion of results is 
somewhat related to the 

goals from the 
introduction  

 

Discusses results in the 
context of the 

experimental procedure 
and experimental goals  

 

Discusses results in the 

context of the 
experimental procedure 

and experimental goals, 
explains limitations of 

methods used  
. 

[2] 
Discusses 
statistics 

No data 

provided 

Discussion of statistics is 

vague or not present  

Incorrect statistical tools 
used or incorrect 

statistical interpretation 

Correct statistical tools 
used, limited discussion of 

statistical meaning  

Correct statistical tools 
used, discussion of 

statistical meaning of data  

Correct statistical tools 

used, discussion of 
statistical meaning of 

data, presents suggestions 
for improvement of 

statistical methods  

[3] 
Organization 

- Incomplete 
No logical order to the 

discussion points  

Organizational mistakes 
impact overall 

understanding of 

discussion  

Some organizational 

mistakes, such starting a 
discussion point then 

finishing the discussion 
point at later in the report  

Discussion follows logical 
order  

Grammar, 
Spelling and 
Formatting 

Clearly not proofread, inappropriate report 
length 

Several errors, text in 
figures too small 

A few errors, major 

sections labeled with 
headings, appropriate 

report length 

Less than 2 errors, 
headings and sub- 

headings used 

Correct grammar and 

spelling, legible text, 
headings, and sub-

headings used 

References  No references cited 

No relevant references 
cited. references not cited 

in a consistent format; 

some references might be 
from Wikipedia 

At least one relevant 

reference cited. Several 
missing citations 

supporting claims. 

At least two relevant 
references cited. 

Two or more relevant 
references cited 

appropriately. All 
statements requiring 

citation are cited using IEEE 
style. 

 


	Module 1 Introduction to BME3181 & Microscopy
	Module 1 Lab Procedure
	Introduction:
	Learning Objectives
	Materials
	Important Terms
	Safety
	Setup:
	Procedure
	Image Acquisition
	Image Analysis

	Post Lab Questions
	Hypothesis
	Data Validity
	Data Reliability
	Limitations & Future work

	Post-Lab Checklist:


	Module 2 Micropipetting & Dilutions
	Pre Lab-Review
	Pre-Lab Checklist:
	Pre-Lab 2: Micropipetting & Dilutions
	Introductory Video:
	Background Information:
	Question 1:
	Question 2:
	Question 3:
	Additional Background Information:
	Question 4:
	Question 4 continued …


	Module 2 Lab Procedure
	Introduction:
	Learning Objectives
	Materials
	Important Terms
	Safety:
	Teamwork:
	Setup:


	Procedure Exercise 1 (Quick Test)
	Procedure Exercise 2 (Pipetting Challenge)
	Procedure Part 3 (Serial Dilutions & Standard Curve)
	Serial Dilution & Standards Data Collection
	Standards Data Analysis

	Post-Lab Checklist:

	Module 3 Fluorescence
	Pre Lab-Review
	Pre-Lab Checklist:
	Pre-Lab 3: Fluorescence
	Introductory Video:
	Question 1:
	Question 2:
	Question 3:
	Question 4:


	Module 3 Lab Procedure
	Introduction:
	Learning Objectives
	Materials
	Important Terms
	Safety
	Prelab Notes:
	Demonstration Notes:
	Procedure Part 1a Remove PFA & Rinse cells
	Procedure Part 1b Prepare & Apply Fluorescent Stain
	Procedure PART 2a Fluorescent Microscopy
	Procedure PART 2b Spectrophotometry
	Procedure PART 3 Quantifying Fluorescent Micrographs
	SET THE SCALE.
	MEASURE CELL AREA.
	Record average cell area across all traces for each sample and note it in RECORD FLUORESCENCE.
	MEASURE RELATIVE FLUORESCENCE.
	Record fluorescence intensity for each image and note it in RECORD FLUORESCENCE.
	RECORD FLUORESCENCE.

	Module 3 Post Lab Questions
	Question 1
	Question 2
	Question 3

	Post-Lab Checklist:


	Module 4 Aseptic Technique & Cell Passaging
	Pre Lab-Review
	Pre-Lab Checklist:
	Pre-Lab 4: Aseptic Technique & Cell Passaging
	Introduction to Aseptic Technique:
	Disinfection
	Preparing the Biosafety Cabinet

	Introductory Videos:
	Introductory to Cell Counting:
	Question 1:
	Question 2:
	Question 3:
	Question 4:
	Question 5:


	Module 4 Lab Procedure
	Introduction:
	Learning Objectives
	Materials
	Important Terms
	Safety
	Hypothesis
	Demonstration Notes:
	Procedure
	Materials Preparation
	Passaging of Cells

	Module 4 Post Lab Questions
	Question 1a
	Question 1b
	Question 1c


	Module 4 Post Lab Activity
	Post-Lab Checklist:
	Introduction Writing Assignment:
	Is there a special format for my report?
	How do I get an A grade?
	Can I get feedback on my paper before submission?
	Introduction Rubric:



	Module 5 Live/Dead Assay
	Pre Lab-Review
	Pre-Lab Checklist:
	Pre-Lab 5: Live/Dead Assay
	1. Quantities of Reagents:
	Total Solution Volume:
	Reagent Volumes:

	2. Theoretical Understanding:
	Question 2a
	Question 2b
	Question 2c
	Question 2d



	Module 5 Lab Procedure
	Introduction:
	Learning Objectives
	Materials
	Important Terms
	Safety:
	Notes:
	Hypothesis
	Procedure:
	Module 5 Post Lab Questions
	Question 1 [Results]
	Question 2 [Discussion i]
	Question 3 [Discussion ii]
	Question 3 [Discussion iii]


	Module 5 Post Lab Activity
	Post-Lab Checklist:
	Methods Writing Assignment:
	Is there a special format for our lab reports?
	How do I get an A grade?
	Can I get feedback on my paper before submission?
	Methods Section Rubric:



	Module 6 Primary Cell Isolation
	Pre Lab-Review
	Pre-Lab Checklist:
	Pre-Lab 6: Primary Cell Isolation
	Question 1:
	Question 2:


	Module 6 Lab Procedure
	Introduction:
	Learning Objectives
	Materials
	Important Terms
	Safety:
	Notes:
	Hypothesis
	1. Steps completed in advance by your instructors:
	Prepare 0.60 % collagenase solution [Already completed by your instructor]
	Determine wet weight of the cartilage to be digested [Already completed by your instructor]

	2. Cell Digestion Procedure:
	3. Tissue Viability Procedure:
	4. Cell Isolation Procedure:
	Module 6 Post Lab Questions
	Question 1
	Question 3
	Reference:

	Post-Lab Checklist:


	Module 7 dsDNA Quantification Assay
	Pre Lab-Review
	Pre-Lab Checklist:
	Pre-Lab 7: dsDNA Quantification Assay
	Question 1 [DNA Standards]:
	Question 2 [Well plate layout]:
	Question 3 [Reagent Calculations]:
	Question 4 [Cell Count & DNA Estimations]:
	Hypothesis


	Module 7 Lab Procedure
	Introduction:
	Learning Objectives
	Materials
	Important Terms
	Safety:
	Notes:
	Hypothesis
	Module 7 Procedure
	1. Lyse cells
	2. Prepare DNA Assay Reagents
	3. Data Analysis

	Module 7 Post Lab Questions
	Question 1 [Discussion i]
	Question 2 [Discussion ii]
	Question 3 [Discussion iii]


	Module 7 Post Lab Activity
	Post-Lab Checklist:
	Group Results & Discussion Writing Assignment:
	Is there a special format for your lab reports?
	How do I get an A grade?
	What do we include in the results section?
	Can I get feedback on my group’s paper before submission?
	Results & Discussion Rubric




